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Welcome to Helix Native
Plug-in

Requirements and Installation
Ready to jump in? The latest Helix Native installer for Mac & Windows® computers can
be downloaded anytime from line6.com/software. Once installed, a free 15-day trial is
available, allowing you to fully try the software on your system. After 15 days, you are
required to purchase and authorize the Helix Native plug-in to continue using it on your
system. Please check the requirements below to make sure your computer and DAW
software meet the minimum requirements.

Thank you for purchasing the Line 6® Helix® Native software, one of the most powerful
and flexible native multi-processing audio plug-ins ever created. Not just for guitarists,
the Helix Native plug-in is also ideal for producers and engineers, sound designers,
film/TV/game composers, electronic musicians, and anyone else seeking to craft new
and exciting sounds and special effects. This guide covers the features & functionality
of Helix Native plug-in v1.60.

System Requirements
To follow are the requirements to install and use the Helix Native software on your DAW
computer system. Note that Helix Native is a 64-bit plug-in and, therefore, requires that
your host DAW application supports 64-bit plug-ins.

The Helix Native plug-in truly is the same set of astounding amps, cabs & effects as
included within the ground-breaking Line 6 Helix® hardware multi-effects units, and
shares the same simple user interface and workflow as the Line 6 HX Edit editor application for Helix family devices.* Due to this design, all presets you create in Helix Native
plug-in are compatible and transferable to Helix hardware units via the HX Edit application, so you can take your presets from studio to the stage—and back again! We hope
it helps drive your search for tonal bliss and spawns years of creativity.

Mac Computers:
•
•
•

Mac OS X 10.10 and 10.11, and macOS 10.12 and 10.13
64-bit AAX Native, Audio Units (AU), VST® (VST2 or VST3) host DAW software
Supported sample rates: 44.1kHz, 48kHz, 88.2kHz, and 96kHz

Windows Computers:
•
•
•

Windows 7 SP1, Windows 8.1, and Windows 10 (64-bit versions only)
64-bit AAX Native, VST (VST2 or VST3) host DAW software
Supported sample rates: 44.1kHz, 48kHz, 88.2kHz, and 96kHz

Minimum Hardware Requirements
•
•
•
•

The Helix Native plug-in

*NOTE: Presets are not compatible between the Line 6 HX Effects multi-effects
devices and Helix Native plug-in - please see "Preset Compatibility with Helix Devices" on page 12.
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Dual-Core 2.0GHz processor or faster
4GB of RAM
100MB of free disk space
Internet connection required for license authorization and use of trial version

Installing the Helix Native Plug-in

*NOTE: If your host DAW application supports VST3, it is recommended that
you do not also install the older VST2 format (VST2 is not selected by default).
The VST2 format is offered for users that have host DAW applications that do
not yet support VST3 plug-ins.

The first step is to sign in to your Line 6 User Account. If you don't already have
one, just go ahead and create one now at line6.com/account - it's free! Then
follow the steps below.

On Windows installation, if you do choose to install VST2, you'll be prompted
to enter a custom install location. Please take note of the VST2 install location
you choose since your host DAW may require that you manually define this
VST2 directory within its Preferences for its VST2 scan.

NOTE: An Internet connection is required for the computer on which you want to
install and run the Helix Native trial version, as well as for the initial authorization,
deauthorization and use of the licensed Helix Native plug-in.
1.

Once signed in, you can head directly to the Line 6 Online Store and purchase
your Helix Native license (see "Purchasing the Software License" on page 5),
or proceed to the next step to install the Helix Native software on your computer
and optionally choose the 15-day free trial.

2.

Proceed to the line6.com/software page and download the Helix Native installer
for your Mac or Windows system.

4.

Once the installation is complete, simply launch your host DAW application and
it will typically scan and find the Line 6 Helix Native plug-in and list it within its
audio plug-in insert menus.

5.

Insert the Helix Native plug-in on a track in your DAW project (see "Quick Start"
on page 8 for help, if needed). You'll initially see the license authorization
screen.
•

•

If You Have Already Purchased a Helix Native License - You'll be prompted
to authorize the computer for this license - please skip ahead to "Authorizing
your Computer" on page 5.
If You Have Not Yet Purchased a Helix Native License - You can either
choose to purchase now (see next section), or start a 15-day free trial. Once the
trial expires, it is necessary to purchase and then authorize the computer with
which you will be using Helix Native, or the plug-in will no longer be functional.

The Line 6 website's software downloads page

3.

Once the download completes, exit your host DAW and all other applications,
then run the installer and follow its steps to complete the installation. If desired,
you can customize the installation to install only the format(s) you require (AAX,
AU, VST3 or VST2) for your particular host DAW application.*

Mac - Custom install options
(click the Customize button to access options)

Helix Native plug-in's purchase & trial mode options

Windows - Custom install options

NOTE: Once you've started the free trial version, you'll see your remaining trial
time displayed at the bottom right of the plug-in window.

Trial status indicator

You can purchase a Helix Native license online at any time during or after your trial
period by simply clicking on this trial status indicator, or going directly to the Line
6 Online Store at https://shop.line6.com/.
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Purchasing the Software License
The Helix Native license is available for purchase from the Line 6 Store.* Just add Helix
Native to your shopping cart, checkout, and the license will be immediately deposited
into your Line 6 User Account. Alternatively, you can first download and install the Helix
Native software and then choose to purchase or run it as a free trial first (see "Installing the Helix Native Plug-in" on page 4). Once you've purchased the Helix Native
license, you then use the plug-in's Authorization screen to authorize your computer to
run Helix Native, as covered in the following section.
*NOTE: By the time you read this, Helix Native may also be available from other
music retailers. If purchased from one of these vendors, your purchased Helix
Native license will be automatically deposited into your Line 6 account as part of
the process.
The initial Helix Native Authorization - Sign In Screen
•

•

2.

Enter your username and password and click Sign In to proceed.
•

•

NOTE: If you are the registered owner of a Line 6 Helix, Helix Rack, Helix LT
device or POD Farm software, you may qualify for a substantial discount on the
purchase of Helix Native! Please see the purchase options on the Line 6 Store.

If You Have an Existing Line 6 Account but Forgot Your Login - Click the
Forgot password/username? option and follow the steps to reset your login
credentials.
If You Don't Yet Have a Line 6 Account - Click the Create a Line 6 Account
link to create one. Or you can do that right now by going here - it's free!
If You Have Already Purchased a Helix Native License with this Line 6
Account - Upon signing in, select the Authorize Computer option and you
should see confirmation that your computer is now successfully authorized.*
You can now start using Helix Native!
If You Have Not Yet Purchased a Helix Native License - You'll be informed
that no license was found on your Line 6 account, and you'll have the option to
buy it now, or start a free trial.

Authorizing your Computer
Before you can use Helix Native, your computer on which you will be running the
plug-in must be authorized for your purchased Helix Native license. Authorization is
accomplished within the plug-in's built-in Authorization screen, via an Internet connection directly from your DAW computer. Once you've installed the Helix Native software,
launch your host DAW application, insert an instance of the Helix Native plug-in on a
track and launch the plug-in window. (Please see "Quick Start" on page 8 for help
on how to insert Helix Native plug-in within a host DAW.)
1.

Sign in - Once launched, the Helix Native Authorization screen is displayed,
prompting you to sign in using your Line 6 User Account username and password.
Helix Native plug-in's purchase & trial mode options

NOTE: Once a Helix Native license is purchased and your computer is successfully authorized, you will no longer be prompted to sign in on each use.

*NOTE: Be sure to Sign In using the same Line 6 Account you used when making
the Helix Native license purchase!
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Removing Helix Native Plug-in

• To Purchase a Helix Native License - Click the Buy Helix Native button and

follow the steps on the secure Line 6 Online Store. Once complete, a Helix
Native license will be deposited into your Line 6 account. Your purchased
license will be found and Helix Native plug-in will authorize on your computer.
• To Use Helix Native in Trial Mode - Click the Start Free Trial button and
you'll be able to use the Helix Native plug-in without restriction on this computer for 15 days (an active Internet connection is required for the Trial Mode).
You may be prompted to sign in for each session when using Helix Native in
trial mode. After the trial period expires, Helix Native will no longer be functional
unless you choose to purchase the Helix Native license.

Should you ever desire to remove Helix Native from your computer system, first quit
your host DAW application, then follow the instructions below. If you are to be installing
and authorizing Helix Native on another computer, you'll want to first deauthorize the
current computer before uninstalling (see previous section).

Mac
To uninstall each plug-in format, move the following files to the Trash:
•

NOTE: Once you've started the free trial version, you'll see your trial time
remaining at the bottom right of the plug-in window. Click directly on this
indicator if you wish to purchase your Helix Native license.

•
•
•

AU plug-in: /Library/Audio/Plug-Ins/Components/Helix Native.component
VST2 plug-in: /Library/Audio/Plug-Ins/VST/Line 6/Helix Native.vst
VST3 plug-in: /Library/Audio/Plug-Ins/VST/Line 6/Helix Native.vst3
AAX plug-in: /Library/Application Support/Avid/Audio/Plug-Ins/Line 6/Helix
Native.aaxplugin (or, you can optionally drag the Helix Native.aaxplugin file
into the /Plug-Ins (Unused) folder)

Windows

Deauthorizing - Moving to Another Computer

To uninstall all plug-in formats:

Once you have purchased and authorized your computer for the plug-in license (or,
while using the free trial version), if you wish to run Helix Native on a different computer,
it may be necessary that you first deauthorize your existing computer.* To deauthorize,
please see "Authorize / Deauthorize your Computer" on page 43.

•
•
•

*NOTE: Line 6 permits you to have a maximum of 3 of your computers authorized
concurrently for the use of your purchased (or trial mode) Helix Native license. To
use Helix Native on a different computer, it is necessary to deauthorize on at least
one of these systems to free up an authorization to be used on another computer.
For further assistance, please contact Line 6 Support.

•
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Choose Start > Control Panel (or, on Windows 10, choose Settings)
Click Programs and Features (or, on Windows 10, choose System > Apps &
Features)
Select Line 6 Helix Native Uninstaller from the list of installed applications
Click Uninstall and follow the on-screen instructions to remove Helix Native

Workflow

What’s in it for Me?
Helix Native is much more than a one-trick audio processing plug-in. It allows you to
combine a multitude of amps, speaker cabs and effects in practically any signal routing
fashion you can imagine. Its integrated preset librarian and IR manager also allow you
to easily customize, backup and manage your built-in library of tones. All is managed
within its simple, but powerful, user interface. Also note that Helix Native is not just
for guitar! The many included amp, preamp, delay, modulation, reverb, compressor,
distortion and other effects can be utilized on any types of recordings, for traditional or
other-worldly results.

This guide contains details of the Helix Native plug-in's features and functionality. All
behaviors are the same on Mac and Windows (and for all plug-in formats - AAX, AU,
VST3 & VST2) unless otherwise noted. For the most part, the many host DAW applications on the market work very similarly in respect to how you insert and utilize effects
plug-ins. However, each host may have some unique features and settings you'll want
to take advantage of, so be sure to read through your host DAW application's user
documentation as well.

If you own a Line 6 Helix®, Helix® Rack or Helix® LT multi-effects device, then you effectively already know how to use Helix Native plug-in! The Helix Native utilizes a similar
user interface as the current Line 6 HX Edit* editor application, therefore, tone creation
and preset management tasks are essentially the same. In fact, you can import any of
your Helix hardware-created presets and use them within Helix Native - and vice-versa!

About Plug-ins
There are many types of “plug-ins” in the world of software. Plug-ins are relatively small
applications that can only run when loaded inside a compatible “host” software application, extending the capabilities of the host. In the world of DAW (Digital Audio Workstation) applications, audio plug-ins provide signal processing for your audio tracks
and/or live audio input.

*NOTE: HX Edit is the newest editor application for Helix family devices that are
running firmware v2.20 or later, and it replaces the previous Helix application,
which is the recommended editor application to be used for Helix family devices
running firmware earlier than v2.20. For best performance, and to take advantage
of all the newest features & functionality, it is recommended that you always use
the latest available version of both the HX Edit application and Helix device firmware. Please also see "Preset Compatibility with Helix Devices" on page 12.

A helpful analogy for audio plug-ins is to think of them as effects pedals. Effects pedals
change the tone of your instrument before the signal reaches your amplifier. As with
pedals, rack effects units, or any other conventional piece of outboard gear, plug-ins
provide familiar knobs, sliders & buttons for tweaking their parameters. Plug-ins process your track signal similarly, but since they run in real-time in your DAW host software, they are non-destructive, allowing you to continue tweaking their settings all the
way up until you do your final DAW project mix-down!

For those new to the Helix products family, although Helix Native plug-in may appear
complex at first glance, it is designed in such a way that once you learn a few basic
concepts, you'll be able to construct both simple and complex tones at nearly the
speed of thought, with very little deep diving required. It's a great idea to try the included Factory & Template presets as a starting point, which you can customize as desired
to start building your own Helix tone collection.
NOTE: For even more details about individual Helix family models and capabilities, please also read through the Helix hardware and software Owner's Manuals
- available from line6.com/support/manuals.
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Quick Start
OK, we know you're eager to jump right in and give Helix Native a try on your tracks!
To follow are steps for adding an instance of Helix Native plug-in within a host DAW
application's audio track to get you up and running.

Create a Session or Project at a supported sample rate (44.1kHz, 48kHz, 88.2kHz
or 96kHz)

2.

Create at least one audio track. Depending on your host DAW application, it
may offer options for "mono" or "stereo" type audio tracks, or just one common
audio track type that can record or import mono or stereo audio, depending
upon the hardware input type you choose for the track. Either way, Helix Native
plug-in can be added into the effects insert of your audio track.

3.

Either record some unprocessed "dry" electric guitar into the audio track, or
import an existing recorded audio file into the track so you have something for
playback.

4.

Now you can proceed to insert an instance of Helix Native on this track by selecting it from the host DAW track's effects insert menu. To follow we've provided examples on several popular host DAW applications.

In the Effects menu, choose Helix Native. Note that Cubase offers both mono
and stereo track types - you can simply choose the Helix Native plug-in and it
will conform to your Cubase track's input & output routing configuration.

3.

You will then see the Helix Native plug-in appear in the Effects Insert window. Be
sure to turn your monitoring system to a low level, then double-click a factory
preset from the plug-in's Presets tab and hit Play to hear the results.

Cockos Reaper

You will find Helix Native within your host DAW application's plug-in insert menus along
with all other audio effects plug-ins. The initial steps in any host DAW application are
as follows.
1.

2.

Reaper is a full-featured host DAW available for both Mac and PC.
1.

Select your audio track within your Reaper project. Within the track header at
the left (or within the Reaper Mixer window's channel strip for this track), click
on the FX track effects insert menu button.

Steinberg Cubase®
The Cubase application is offered for both for Mac & PC. It supports the VST3 plug-in
format.
1.

Inserting Helix Native plug-in on a Reaper 5 audio track

Select your audio track within the Cubase project. Within the track's Inspector
at the left of the track (or within the Cubase Mixer window's channel strip for this
track), click on one of the slot's menus in the Inserts section.

2.

In the FX window, choose the plug-in format type. On Mac, Reaper supports
both the AU (Audio Units) and VST3 plug-in formats, so you can choose either.
On PC, choose VST3. Select Line 6: Helix Native and click OK.

3.

You will then see the Helix Native plug-in appear in the FX window. Be sure to
turn your monitoring system to a low level, then double click a Factory preset
from the plug-in's Presets tab and hit Play to hear the results.
NOTE: Some Mac host DAW applications allow you to use instances of plug-ins
of different format types (for example, in Reaper you can insert both VST and
AU type instances of Helix Native within the same project simultaneously). For
some actions, such as changes within the Helix Native Preset or IR Libraries and
Preference options, changed settings will not take effect immediately across
currently open Helix Native plug-in instances of different format types until you
close and re-open the plug-in windows.

Inserting Helix Native plug-in on a Cubase Pro 9 audio track
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Apple Logic Pro

Avid® Pro Tools®

Logic Pro is an extremely popular host DAW for Mac. It supports the Apple Audio Units
(AU) plug-in format.

The Pro Tools host DAW application for is available for Mac & Windows. It supports the
Avid AAX plug-in format.

1.

Select your audio track within the Logic Pro project. Within the track's Inspector channel strip (or within the Logic Pro Mixer window's channel strip for this
track), click on the Audio FX track effects insert menu.

1.

Select your audio track within your Pro Tools project. Within the track header at
the left of the track (or within the Pro Tools Mixer window's channel strip for this
track), click on one of the slot's menus in the Inserts section.

Inserting Helix Native plug-in on a Pro Tools 12.6 mono audio track

2.

In the plug-in menu, choose Helix Native. Note that Pro Tools offers both mono
and stereo track types, therefore, you'll have different sub-options depending
on your track's type:
•

Inserting Helix Native plug-in on a Logic Pro X audio track

2.

•

•

3.

•

In the FX window, choose the Audio Units (AU) plug-in format type and select
Line 6 > Helix Native. Note that Logic Pro offers both mono and stereo track
types, therefore, you'll have different sub-options depending on your track's
type:
3.

If inserting on a mono track - You'll have the option to choose either Mono
(the plug-in's output is summed to mono) or Mono->Stereo (the plug-in's
output is stereo).
If inserting on a stereo track - It is recommended to select the Stereo option
here, which provides stereo in/out processing. The Dual Mono option inserts
two mono instances of the plug-in (each accessed via the L and R buttons at
the top of the plug-in window). Each mono instance processes the left and
right audio channels of the stereo track discretely, but this can quickly utilize
a great deal of CPU power, so we don't recommend using it.

If inserting on a mono track (as shown above) - You'll have the option to
choose either mono (the plug-in's output is summed to mono) or mono/
stereo (the plug-in's output is stereo, assuming the track is routed to a stereo
output).
If inserting on a stereo track - Only a stereo option is offered here, which
provides stereo in/out processing. (Note that Pro Tools does offer a dual
mono option for some plug-ins, but this is not supported by Helix Native
plug-in.)

You will then see the Helix Native plug-in appear in the Effects Insert window. Be
sure to turn your monitoring system to a low level, then double-click a Factory
preset from the plug-in's Presets tab and hit Play to hear the results.
TIP: Most host DAWs also allow you to insert plug-ins on Send, Bus or Aux track
types. Host DAWs differ slightly in their naming and features of these track types,
but their main purpose is to allow you to insert a single instance of your plug-in
and then route the output of any number of audio tracks into it to process them
using the same effect. This is the preferred way of processing multiple tracks
since, obviously, one instance of your plug-in utilizes less CPU power as compared to inserting individual instances on each audio track! Please refer to your
host DAW's documentation for details.

You will then see Helix Native appear within the plug-in window. Be sure to turn
your monitoring system to a low level, then double click a Factory preset from
the plug-in's Presets tab and hit Play to hear the results.

Once you insert an instance of Helix Native and load a preset, the preset's contents are
displayed within the Signal Flow Window, with model menus, parameters and automation control options available within the tabs of the Inspector Window.
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About Latency

This allows you to load & customize any of the provided Factory presets, create your
own presets, configure automation controller assignments, manage presets & Impulse
Responses, as well as backup all your tones to your computer. Even better, all your
saved creations can be transferred between Helix Native plug-in and the HX Edit application, allowing them to also be used on a Helix hardware device as well (see "Preset
Compatibility with Helix Devices" on page 12 for details).

Since this input signal is being fed round-trip - into your audio interface, through the
DAW software and back out your audio interface's outputs - it is subject to some
amount of "latency." Latency is the time between when you pluck a note on your guitar
and hear the resulting audio output through your monitoring system. Latency is a function of your audio interface, host DAW software and the recording capabilities of your
computer system. You can generally get the lowest latency by reducing your buffer size
options for your audio interface driver within in your host DAW software's Preferences
- please see your DAW software’s documentation for details.

Live Input Monitoring Through Helix Native Plug-in
Another great benefit of audio effects plug-ins is the ability to monitor your input signal
through the plug-in inserted on the track. This allows you to dial in the desired tone,
such as a customized set of amp, cab & effects within the instance of Helix Native, and
then hear your guitar (or other track input signal) processed by it in real-time. Once you
hit record, only your "dry" guitar signal is actually recorded into the track, which provides the huge benefit of being able to completely change the plug-in settings at any
time, right up until you do a final mix-down of the DAW project!

Optimizing the Input Level
The level of the input signal entering the Helix Native plug-in can affect the overall gain
and saturation of your tones, therefore, it is essential to “gain stage” accordingly. It is
important to note that most Helix Native Amp & Effect models are designed to receive
"Instrument" level input signals, much like plugging an electric guitar directly into the
same type of amp or effects pedal we modeled them after. To follow are several tips for
achieving the optimal signal level.

Live Input Monitoring is a function of your host DAW application, and is typically accomplished by the following steps. Each host DAW is slightly different, so be sure to
consult your DAW application's documentation for details.
1.

Configure your audio track's input options to receive input from whatever physical input your guitar (or desired instrument) is plugged into.

2.

Insert Helix Native on the track, as described in the previous section.

3.

Set the track's Record Arm button to "on" so that the track receives audio input.

4.

Activate the track's "Input Monitoring" feature - this is typically a button found
near the Record Arm button. This feature allows the live track input to be fed
through the DAW track and all plug-ins inserted on the track.
Record Arm

NOTE: Please also see "Master Input & Output Level Controls" on page 26.
•
•

Input Monitor

Optimal Input
Range Indicator

An audio track in Cubase configured with Record Arm & Input Monitoring active

NOTE: When utilizing your DAW track's "Input Monitoring" feature, you'll want to
be sure to disable any "Direct Monitoring" signal on your audio interface (many
interfaces offer an optional function that routes your input signal directly to its
outputs, without going through the DAW software). This way you'll hear only the
input signal fed through the Helix Native plug-in. See your audio interface's documentation for details.
5.

For the most accurate results for recording "dry" electric guitar (or bass), we
recommend that you use an audio interface with a “Hi-Z” or “Instrument” input.
For monitoring your input signal level (or the playback level of any clips within
your track), reference the Master Input Level meter within the plug-in.

Master Input
Level Slider

Multi-color
Input Meter
The Master Input Level controls
•

Now when you strum your guitar, you should hear your signal through the track
with the Helix Native processing applied. You can hit the Record button and try
a pass at recording your performance. Upon playback you can then experiment
with tweaking the Helix Native settings even further!

•
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The Optimal Input Range Indicator provides a guideline for where you should
keep your input level, between -36 dB to -12 dB.
The Multi-color Input Meter also provides guidance - basically, strive for keeping your input level in the green and yellow, and avoid the blue (signal is too low)
and red (signal is too high).

•

•

•

The Signal Flow Window - Where you can add and move amps & effects blocks,
and customize your complete signal path routing - see "The Signal Flow Window"
on page 26.

If your audio interface offers input level adjustment, it is typically best to adjust
it there to keep the recording level entering the plug-in within this optimal range.
If needed, you can adjust the plug-in Master Input Level Slider to fine-tune
the level.
Guitars with active pickups may have a hotter output than traditional passive
pickups. If your guitar utilizes active or especially high output pickups, set your
audio interface or preamp's input “pad” to on, if available.
Clipping, as indicated when the red Clip Indicator lights up, should always be
avoided on both the plug-in's input and output meters.

The Inspector Window - Where you can choose from the huge selection of models, edit their parameters, and create and manage parameter automation control
- see the Inspector Window chapters on page 31 and page 34.

Customizing the Helix Native Plug-in Window
Resize the Plug-in Window - The plug-in's window is resizable to allow you adjust
the window size that best suits your screen and workflow. Simply click and drag
using the "grab handle" at the bottom right of the plug-in window to reduce or increase the window size independently for any instance of the Helix Native.

Clip Indicator

The Input meter showing a clipped input level

GUI Overview
The Helix Native plug-in has a very simple, easy-to-use interface which functions as
both a Librarian for your Helix Preset and Impulse Response files and as an Editor to
create and customize your tones.
Presets
Tab

Impulses Show/Hide
Tab
Librarian

Signal Flow
Window
Drag the "grab handle" on the bottom right of the plug-in window for resizing

Show or Hide the Library Panel - It is also possible to show or hide the Presets/
Impulses Library panel independently for each instance of the plug-in, by clicking
on the toggle button at the top left of the Signal Flow window.

EDITOR

LIBRARIAN

The Library Panel's Show/Hide Button

Edit
Tab

Inspector
Window

Preferences & Account Settings Menu

Automation/Controller
Assign Tab

At the bottom left of the plug-in window, click on the "gear" icon to launch the Preferences & Account Settings menu, where you can access plug-in settings, license and
account options, and more - please see page 42.

Navigation within the plug-in's user interface is divided into three main windows:
The Librarian Window - For managing presets and impulse response (IR) files see "Presets Panel" on page 15 and "Impulses Panel" on page 18.
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Preset Compatibility with
Helix Devices

HX Edit Application
Line 6 HX Edit is the editor/librarian software for use with Helix hardware devices that
are running firmware version 2.20 or later. For best performance, it is recommended to
use the latest version of both the HX Edit application and Helix firmware. If you own a
Helix that is still running a firmware earlier than v2.20, you'll need to update the Helix
device's firmware to the v2.20 firmware or later, or use the previous Helix application
with your Helix device.

Helix preset, setlist and bundle files are compatible and transferable between the Helix
Native and Helix family devices (Helix, Helix Rack and Helix LT).* Presets, setlists and
bundles are imported to and exported from these Helix hardware devices on your computer by the use of the HX Edit editor/librarian software. This compatibility is the foundation of the Line 6 "Studio to Stage" concept, allowing you to load and transfer your
tones between Helix Native plug-in and Helix hardware!

For optimal preset compatibility between Helix Native plug-in and Helix hardware, you
should always be sure to use matching versions of the Helix Native, Helix firmware, and
the HX Edit (or Helix) application. The easiest (and recommended) way to be sure your
presets are compatible is to update to all the latest versions available for Helix Native,
Helix firmware and HX Edit. All Line 6 software is available for download from line6.com/
software.

*NOTE: Presets and setlists exported from Line 6 HX Effects™ devices are not
compatible with the Helix Native plug-in or Helix family devices. Likewise, presets
and setlists exported from Helix Native or Helix devices are not able to be imported
into HX Effects devices.
However, it is possible to Copy and Paste individual blocks, along with their current
settings, between HX Edit with an HX Effects device and Helix Native. See the following "Block Copy and Paste" section.

HX Edit Backup Files
The HX Edit application includes a feature that creates Helix Backup (.hxb) files that can
be utilized to restore a Helix device's presets, IRs and global settings. Helix Native does
not currently include this feature and, therefore, does not support creating or opening
HX Edit Helix Backup files.

Block Copy and Paste

TIP: If you own a Helix device, be sure to check the "Helix compatible" version
number (found in the Helix Native About box - see page 11) to determine the
recommended Helix firmware version you should use for maximum preset compatibility.

Using the Copy and Paste Block commands, you can copy and paste any individual
block between any presets within any instance of Helix Native, as well as between Helix
Native and HX Edit (with any Helix or HX Effects type device connected). Restrictions
apply when copying and pasting some block types, depending on the Helix hardware
in use and the paste destination - please see "Cutting, Copying, Pasting & Clearing
Blocks" on page 27.

Presets, setlists and bundles can simply be imported into the Helix Native or the HX
Edit app using their Import functions, as covered in the following sections. It is also
possible to drag and drop presets directly between the applications' Preset panels.
Once imported into the HX Edit application, presets are immediately loaded onto your
connected Helix device, replacing the presets within the device's internal memory.
When importing presets into the Helix Native Presets Library, they are then available for
all instances of the plug-in.

Input & Output Block Settings
When Importing a Helix Hardware-exported Preset into Helix Native - All Input and
Output blocks currently set to physical Inputs and Outputs (other than "None") will default to the "Host" setting within the plug-in.

NOTE: As with all plug-ins, the specific settings you last used within your existing
plug-in instances are retained as part of your host DAW project and not affected
unless you manually load a different preset into the plug-in's Signal Flow. Instances of the Helix Native plug-in that already exist in previous host DAW projects will
also reference the current plug-in Presets Library lists when you load the DAW
project again.

When Importing a Helix Native-exported Preset into Helix Hardware - All Input and
Output blocks currently set to "Host" will default to the "Multi" setting within the Helix
hardware. Any Input block set to "None" will remain as set to "None" within the hardware.

Send, Return, FX Loop & Looper Blocks

Due to the obvious differences of Helix hardware devices having numerous physical
inputs and outputs, there are some settings, block type & controller support variances
when sharing presets between the Helix Native and Helix hardware. These differences
are detailed in the following sections.

When Importing a Helix Hardware-exported Preset into Helix Native - These block
types are only functional within Helix hardware and, therefore, their parameters are not
editable, and these blocks have no routing functionality within Helix Native.
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If you are to be sharing Helix presets between Helix Native and Helix devices, it is a
good idea to build and maintain your IR Libraries similarly on each to allow the same IR
files to be utilized for your presets that include them. Please see "Impulses Panel" on
page 18 for details.

NOTE: If an existing Send, Return or FX Loop block is toggled as "active" via its
Bypass switch, it can reduce or fully mute the path's audio signal, depending on
the block's Mix or Dry Thru parameter settings. To ensure these block types are
not affecting the plug-in's signal path, simply toggle the block to bypassed.
If you load a preset that happens to include any of these types of blocks, you'll see
them appear within the Signal Flow with an indicator to remind you they are "unsupported" within the plug-in.*

Hardware Controller Assignments
Helix Floor, Rack & LT devices and the HX Edit editor application offer the ability to
create several types of "controller assignments" to provide remote control of Helix parameters via Helix footswitches, expression pedals and external MIDI gear. These controller assignments are saved and retained within Helix hardware-exported presets. If
you happen to open a preset within Helix Native that includes them, you'll see these
controller assignments represented by their parameter values displayed in white and in
brackets.

An FX Loop (Snd/Rtn) and Looper (Loop) block within a Helix hardware-exported preset

*NOTE: Within the Preferences - General window, you can enable the option for
Helix Native to automatically strip out all unsupported block types from presets
whenever importing Helix Presets, Setlists or Bundles (see page 42).

Helix hardware
assignment indicator

However, regardless of this Preference setting, it is still possible to Paste one of
these unsupported blocks into Helix Native from the HX Edit app, if it remains as
the most recently copied item in your clipboard.
Indicator that a parameter includes a controller assignment

When you select one of these unsupported blocks within the Signal Flow, you'll see a
reminder within the Edit tab to alert you it is non-functional, and see that its parameters
are not editable (dimmed). However, these blocks and their original settings remain fully
functional if and when the preset is exported from Helix Native and imported back into
HX Edit.

Helix hardware controller assignments offer no functionality within Helix Native plug-in,
and any parameter itself that includes an assignment remains adjustable and functional
within Helix Native. MIDI controller assignments created within HX Edit are supported
and functional within Helix Native. These controller assignments also continue to be
retained in the preset, even once exported from Helix Native, allowing them to still function if imported back into a Helix device again.
There are a few things that are good know about these Helix hardware controller assignment types, as described below. If you'd like more info, please see the Helix devices' Owner's Manuals.
TIP: Note that, within Helix Native, you can utilize your host DAW application parameter automation functionality to control the bypass of blocks and parameter
values in real-time! Please see page 34.

An "unsupported" block's parameters within the Helix Native Edit tab

Snapshots & Snapshot Assignments

NOTE: Note that it is not possible to add Send, Return, FX Loop or Looper type
blocks to your tone from the Helix Native model menu - the Send/Return and
Looper menu categories of the Edit tab's Model Browser remain non-selectable.

Snapshots & snapshot assignments created and saved within a Helix device's preset
are compatible when the preset is loaded in the Helix Native plug-in, and vice-versa.
However, there are a few specific functions that can exist within Helix hardware-created
presets that Helix Native does not support, as described below.

Impulse Responses

•

Impulse Response (IR) files are able to be utilized within IR blocks of Helix Native just
as they are within Helix devices. You can simply import IRs using the Impulses panel to
build your Library of IRs that are available to Helix Native. Helix hardware retains its own
separate IR Library (managed by using the HX Edit application).

•

13

Helix hardware Command Center message data (see previous section).
Line 6 Variax instrument tunings and other Variax parameter settings.

These types of data within snapshots are essentially ignored by Helix Native, with all
other supported Snapshot settings are recalled just as on Helix hardware. Both supported and non-supported snapshot data is retained within your Helix Native-exported
presets when loaded on Helix hardware again. Please also see "Working with Snapshots" on page 23.

Helix Native does not support the transmission of these types of commands and, therefore, essentially just ignores any Command Center assignments that may exist within
an imported Helix preset. Existing Command Center data is retained when exporting a
preset from Helix Native.

Automation Controller Assignments

*NOTE: The current Snapshot, along with all its settings, can be copied and
pasted using the Copy Snapshot and Paste Snapshot commands either within
the current Helix Native preset or within the current HX Edit preset, but not between the Helix Native plug-in HX Edit app and. Also see "Copying, Pasting &
Renaming Snapshots" on page 25.

Since parameter automation is a functionality specific to DAW hosts and software plugins, all automation controller assignments saved within a Helix Native-exported preset
will be ignored when the preset is loaded on Helix hardware devices. However, these
assignments are retained if and when the preset is exported from a Helix device. See
"Controller Assignment for Automation" on page 34.

Bypass Assignments

Customized Hardware Footswitch Labels and LED
Colors

A common practice within Helix devices is to configure "bypass assignments" where
the bypass parameter of blocks are then toggled Off/On via the device's footswitches, or optionally by expression pedals or external MIDI commands. Currently, MIDI
bypass assignments are supported in Helix Native (see next section), but not other
types of bypass assignments that can be created within Helix hardware. If you happen
to change the bypass state of block that includes a Helix hardware bypass assignment
and export the preset, you will overwrite the saved state of the assignment when the
preset is imported back into a Helix device.

Helix devices include the ability to customize the labels displayed on their "scribble
strips" (on Helix floor and Helix Control devices) and on-screen footswitch labels (on
Helix LT devices), as well as to customize the color displayed for their footswitch LED
lights. This data is stored within a Helix hardware-exported preset, but is not utilized by
the plug-in, nor altered when importing or exporting the preset with Helix Native.
TIP: Remember, you can create an unlimited collection of backups of your presets,
setlists and bundles from both Helix Native plug-in and the HX Edit application
using their Export functions. It is good advice to follow the golden rule, "backup
early and often" so that you always have copies of your favorite Helix tones!

Controller Assignments
Helix device users can create "controller assignments" to map the control of parameters to a Helix Expression pedal, footswitch or external MIDI controller device (such as a
wah or volume, a delay's Mix parameter, etc.) Currently, MIDI In controller assignments
are supported in Helix Native plug-in (see next section), but not other types of controller assignments that can be created within Helix hardware. If you edit a parameter that
includes a Helix hardware controller assignment, and then export the preset from Helix
Native, your last-used parameter value is the same value the parameter will default to
upon import within a Helix device.

Computer Processing Management
In order to maintain preset compatibility with Helix family devices, Helix Native incorporates similar processing management as the DSP management system utilized on
Helix hardware. That is, Path 1 and Path 2 within an instance of the plug-in each have
a maximum computer processing limit. Once this limit is approached on either path,
the Edit tab's Model Browser options become dimmed if the specific models require an
amount of processing power that would surpass maximum limit. (Please see "Availability of Models within the Model Browser" on page 31.) This way, any preset created
and exported from the Helix Native is ensured to be able to be imported and utilized on
Helix hardware devices.

MIDI In Bypass & Controller Assignments
Helix device users can create MIDI In bypass assignments to remotely toggle the
bypass of most block types, and MIDI In Controller assignments to remotely control
most Helix parameters, via external MIDI controller devices or MIDI software. These
MIDI In assignments are also supported by Helix Native. Likewise, MIDI In bypass and
controller assignments created in Helix Native presets and also supported when the
preset is imported into Helix devices via the HX Edit application. See "MIDI Bypass &
Controller Assignment" on page 39.

TIP: Note that if you just can't manage to cram in all the effects you want in an
instance of the Helix Native plug-in, you can always simply insert an additional instance of the plug-in! Please also see "Tips to Optimize Processing Power Usage"
on page 30.

Command Center Assignments
The Command Center in Helix devices provides the ability to assign the transmission of
MIDI, CV, Amp switching and other commands to Helix hardware switches and expression pedals.
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Presets Panel

Setlist Commands - Click on any command in this row to perform the selected
action on the current Setlist.
Seltlist Menu - Click here to display one of the 8 Setlists of the Presets Library.
Right-click directly on the current Setlist's name here to rename it.

The Librarian's Presets Panel provides functionality for loading, importing & exporting Helix presets & setlists to manage the plug-in's Presets Library. The contents of the
Presets Library is stored commonly for Helix Native, and changes you make to this
Library affect what presets appear within all instances of the Helix Native plug-in on
the computer.

NOTE: It is also possible to import and export all setlists, including all your
presets and their last-saved settings by using the Bundle options found in the
Preferences window. Please see "General Screen" on page 42.

Helix Native Factory Presets

Presets Tab

The very first time you insert an instance of the Helix Native plug-in after installation,
you'll see a pop-up notice informing you that the set of Factory Presets will be automatically imported. You'll then see the first two setlists, titled FACTORY 1 and FACTORY 2, and the last setlist, titled TEMPLATES/OTHER, all of which become populated
with numerous Factory Presets to provide an easy start for your own sonic creations!

Setlist Commands
Setlist Menu
Preset Commands

Most presets within the FACTORY 1 & 2 setlists are intended for guitar, and you'll also
see quite a few intended for bass (cleverly titled starting with "BAS"). If you're wanting
to utilize Helix Native for processing vocals, or for discrete left/right channel input and
output effects for a stereo Aux or Bus track within your DAW project, look in the TEMPLATES/OTHER setlist for the "VOX" and "AUX" titled presets. Please also be sure to
read through "The Signal Flow Window" on page 26 to see the many capabilities for
mono, stereo, serial and parallel signal routing.

Last Loaded Preset
Selected Preset

TIP: If you want a clean start, we've also provided the options Clear Preset Library (to clear out all data from all your plug-in's current Library presets) and Restore Factory Setlists (to restore the original Helix Native Factory Setlists) - see
"General Screen" on page 42.

The Presets panel

Presets Tab - Click on this tab to display and place focus on the Presets panel.

Loading Presets

Preset Commands - Click on any command in this row to perform its action on
the currently selected Preset(s).

Double-click on the desired preset from the Presets panel list to load it into the Signal
Flow window as the current tone, with all blocks' parameters accessible within the Edit
tab. You can also use the Next/Previous preset buttons at the top of the Signal Flow
window (see "Navigating with the Next/Previous Preset Buttons" on page 20).
Alternatively, if you wish to load a preset that exists as a saved Helix preset (.hlx) file on
your computer, you can do one of the following:
• Use the Import command and select the desired preset from your computer,
then double-click the imported preset within the Presets list to load it as the
current tone.
• Use the Open from Disk option from the menu at the top of the Signal Flow
window. This loads the preset directly into the plug-in's Signal Flow as the current tone, but does not import it into the Preset Library.

Last Loaded Preset - When you double-click on any preset in the panel, it loads
it into the Signal Flow as the current tone in use by the plug-in. The white vertical
line at the left of the preset slot indicates that this is the last preset that was loaded.
NOTE: It is important to note that, once a preset is loaded as the current tone,
changes to the current tone does not affect the preset within the Presets Library panel unless you specifically Save the tone to the Preset Library - see
"Using the Preset File Menu" on page 21.
Selected Preset - Click once on any preset in the panel to select it, and you'll see
it appear highlighted, as shown above. The selected preset is the one that is acted
upon when choosing any Preset Command. Note that when you load a preset, it
remains the selected preset until you click on any other preset within the panel. It is
also possible to select multiple presets to perform actions on them simultaneously,
as covered in the following sections.

NOTE: Remember to Save if you wish to retain any changes you've made to the
current tone to create it as a preset that can be utilized by other Helix Native instances. Please see "Using the Preset File Menu" on page 21.
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The Default Preset

TIP: Using the Preset panel's Export command makes a copy of the selected library preset in its last-saved state and saves it to your hard drive. If you wish to save
the tone currently in use within the plug-in's Signal Flow, with all edited settings
intact, use the File - Save options (see "Using the Preset File Menu" on page 21).

Whatever preset resides within location 01A of the first Setlist becomes the designated Default Preset. You'll see that this preset is the one automatically loaded into the
Signal Flow every time you create a new instance of the plug-in. This allows you to set
any preset you like as the Default Preset for Helix Native - by simply importing or saving
it to this Preset Library location! All settings that you customize and save to this library
Default Preset are recalled when loaded, including automation assignments, routing
configuration, block bypass states, etc.

Renaming, Reordering, Copying and Pasting
Presets
These functions allow you to customize your presets within the Presets panel. Choose
Rename, Copy or Paste from the row of Preset command buttons and it will act upon
the selected (highlighted) preset location. Or, optionally right-click on an individual
preset location within the list to open a context menu with these same commands.
For most commands, it is also possible to multi-select a number of presets by using
Shift+click to select a contiguous set of presets, or Cmd+click (Mac) or Ctrl+click (Windows) to select a non-contiguous set.

Importing and Exporting Helix Preset Files
Helix presets are able to be exported from the Presets Library to be copied and saved
to your computer as individual (.hlx) files, allowing you to create a limitless collection of
tones that can be imported back into your Presets Library at any time.

Drag and Drop Presets
Drag and drop any preset (or multi-selected presets) directly to or from the plug-in's
Presets panel to perform the following actions.
•

To Import a Helix Preset File - Click once to select the desired preset location
within the Presets panel and click the Import preset command.* A brief dialog will
warn you that importing will overwrite any preset information in the selected
Library location. Click Yes to continue. A system window will display a file browser for selecting the preset you wish to import. The imported preset will then remain
available within the built-in Presets Library for all instances of the plug-in.

•

NOTE: Importing a preset into the Preset Library does not also automatically
load the preset into the Signal Flow of the plug-in. If you wish to load the imported preset as the current tone, double-click on the preset within the library
location.

•

NOTE: This "Load" action loads the preset as the one used within this
instance of the plug-in, but it does not import the preset into the plug-in's
Presets Library. Optionally, you can add this loaded preset by using the
File > Save to Library option within the Signal Flow window - see "Using
the Preset File Menu" on page 21.

To Export a Helix Preset - Click once to select the desired preset within the Presets panel, then click the preset Export command. This creates a copy of the preset from the Helix Native plug-in's Presets Library and saves it to your computer as
a Helix preset (.hlx) file. The familiar Mac or Windows computer's Save As window
is presented, in which you can edit the filename and choose a destination folder.
By default, all .hlx files are exported to:
•
•

Export - Drag any preset from the plug-in's Presets panel into any folder on
your computer to export a copy of the .hlx Helix preset file and save it there.
Import - Drag any saved .hlx Helix preset file from your computer's hard drive
and drop it directly into a slot within the plug-in's Presets panel to import it into
the Presets Library. (Note that this does not automatically load the preset as the
current tone in the plug-in - Double-click the preset slot you imported into to
load the preset.)
Load - Drag any saved .hlx Helix preset file from your computer's hard drive
and drop it within the plug-in's Signal Flow window to load it.

•

Mac - /Documents/Line 6/Tones/Helix folder
PC - \My Documents\Line 6\Tones\Helix folder

•

*NOTE: Clicking once on a preset within the Presets panel selects the Library
preset, not to be confused with loading the preset into the Signal Flow as the
current tone (double-clicking on a preset loads the preset). The preset that
is selected (highlighted) within the Presets panel allows you to then execute
commands upon it (Export, Reorder, Copy, etc. - see next section).
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Reorder - Drag any preset up or down and drop it into another location within
the Presets panel to reorder the presets within the current setlist. When the
preset is dropped in the new location, the surrounding presets are shifted
upward or downward accordingly.
Transfer to or from Helix Hardware (for Helix/HX Edit application owners) With a Helix device connected, you can drag a preset directly from Helix Native
plug-in's Presets panel and drop directly into the Presets panel of the HX Edit
application to import the preset into your Helix device. Likewise, you can drag
a preset from the HX Edit app into Helix Native to import your device's library
presets into the plug-in (also see "Preset Compatibility with Helix Devices" on
page 12).

Importing and Exporting Setlists

Importing and Exporting Helix Bundles

The Presets panel allows you to Export to save a copy of the currently loaded setlist, including all its presets, to a Helix setlist file (.hls). This is very handy for making a backup
of all presets within a setlist, so that a group of presets can easily be imported back into
the plug-in's Library in a single action.

A Helix bundle file (.hlb) includes all 8 setlists that make up the plug-in's current Library,
including all presets and saved settings, all wrapped up in a single, tidy package. This
makes it easy to store a backup of your complete Presets Library - and easily restore
your Helix Native Library by importing the bundle. The options for importing and exporting a Bundle are found within the Preferences window (also see page 42).

To Import a Setlist - Click Import Setlist. This will prompt you to ensure that you
wish to replace the currently selected setlist and its presets within the plug-in's
Presets Library. Continue through the "Open" window to select the setlist you wish
to import.
To Export a Setlist - Click the Export Setlist command to save a copy the current
setlist as a Helix setlist file on your hard drive. By default, setlists are exported to:
•
•

Mac - /Documents/Line 6/Tones/Helix/Setlists folder
PC - \My Documents\Line 6\Tones\Helix\Setlists folder

Use the buttons in the Preferences window for Importing and Exporting Helix Bundles

Changing Setlists

To Import a Bundle - Click the Import Bundle button found in the Preferences
> General window. This will prompt you to ensure that you wish to replace all
setlists and presets within your Presets Library with those from the selected
bundle file. Continue through the “Open” window to select the bundle you wish to
import.

To change the active setlist shown within the Presets panel, click on the Setlist menu
and choose from among the 8 setlists stored within the plug-in's Library. The currentlyselected setlist will be indicated with an “open folder” icon in the menu.

Renaming Setlists

To Export a Bundle - Click the Export Bundle button found in the Preferences
> General window to create a copy of the plug-in's complete Presets Library as
a Helix bundle (.hlb) file, stored on your computer. By default, all bundle files are
exported to:

To rename the current setlist, Right-click on the current setlist's name within the Setlist
menu and enter your new title.

•
•

Mac - /Documents/Line 6/Tones/Helix/Bundles folder
PC - \My Documents\Line 6\Tones\Helix\Bundles folder

NOTE: Bundle files do not contain any of the Impulse Response (IR) files that
you may have imported into the Impulses Library. You can separately export IRs
from within the Impulses Panel - see "Importing and Exporting Impulse Responses" on page 18.
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Impulses Panel

IR Formats and Restrictions
Helix Native can import any vendor's mono or stereo .wav file IR, regardless of its bit
depth, length, or sample rate frequency. Once imported, files are automatically conformed to the Helix-compatible IR properties (48kHz, 16-bit, Mono, 2048 or 1024 samples). While this is very convenient, please be careful not to import just any .wav file as
an IR or you may experience unexpected sonic results. SysEx files are not supported.

The Librarian's Impulses Panel provides a list of up to 128 Impulse Response files
(along with their respective index numbers), which are available to all instances of the
Helix Native plug-in. Initially, this Impulses panel is empty, awaiting you to import Impulse Response files. Once imported, Helix Native presets will access the IRs displayed
within the Impulses panel by their index number only. Impulse Response files themselves are not directly associated with presets.

Helix Device Users: Helix also supports the use of IR files, and if you plan on
utilizing your Helix presets with both Helix Native plug-in and a Helix device, the
best practice is to import the same exact IR files into both, and in the same index
list order. This allows all IR blocks to reference and load the same indexed IR files
for all presets that use them.

Impulses Tab
IR Commands

Importing and Exporting Impulse Responses

Selected IR

IR Index Numbers

To Import an IR - Click once to select the desired index location within the Impulses
panel and then select the Import command button at the top of the Impulses list. Continue through the File-Open window to select the desired IR file. If you select multiple IR
files, they will all be imported into contiguous index locations.
To Export an IR - Select the desired IR(s) within the Impulses panel and click the
Export command to display the Save As dialog.* By default, IRs are exported to:
• Mac - /Documents/Line 6/Tones/Helix/IRs folder
• PC - \My Documents\Line 6\Tones\Helix\IRs folder

The Impulses panel

Impulses Tab - Click on this tab to display and place focus on the Impulses panel.

You may also drag & drop to and from the Impulses panel to import and export IRs - see
the following section.

IR Commands - Click on any command in this row to perform its action on the
currently selected IR(s).

TIP: Exporting your complete list of IRs is a nice way to keep a backup of them
all in one place on your computer. It is helpful to rename your exported IR files to
include their stored index ID number at the start of the title (001 through 128, as
shown in the image at the start of this chapter) to easily identify what IR slots they
should be imported back into.

IR Index Number - Each IR slot includes an Index Number at its left. This index is
what is referenced by an IR block within a Helix preset, allowing the block to utilize
whatever actual IR file is imported into this IR Library slot.
Selected IR - Click once on any IR in the panel to select it, and you'll see it appear
highlighted, as shown above. The selected IR is the one that is acted upon when
choosing any available IR Command.

Copying, Pasting, Renaming & Clearing IRs

What are Impulse Responses?

These functions can be performed by clicking the command buttons above the Impulses index list and will act upon the selected (highlighted) IR. You can also right-click
on any IR slot to choose these options from the context menu.

Impulse Responses (or “IRs”) that can be used in Helix Native are audio files that are
the result of capturing the sound of a test tone (frequency sweep) through a guitar or
bass amp speaker cabinet, which has been de-convolved with the original tone signal. This
represents the frequency response of the cabinet itself and can be used to simulate the way it
alters the sound. This is similar to a convolution reverb, but with a much shorter decay.

TIP: We've also provided a handy Clear IR Library option, to clear out all IRs
from the plug-in's current IR Library in one click - see "General Screen" on page
42.

You can add an IR block to your preset as an alternative to using one of the Cab blocks
to provide speaker cabinet simulation along with an Amp block. Several companies
now offer large selections of professionally recorded IRs that can be used in Helix Native,
or you can even do some research on how to record and create your own.
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Drag and Drop IRs
There are several drag and drop options that allow you to import and export, single or
multiple, IR files between your computer’s hard drive directories and Helix Native, as
listed below.
•

•

•

Import - Drag one or more IR files from your computer's hard drive folder directly into the Impulses panel. When multiple files are being dragged in, they are
imported in sequence, starting with the selected IR index slot.
Export -Select one or more IR index locations and drag from the Impulses list
view directly to your computer to export the IR files to the selected hard drive
folder.
Copy - It is also possible to drag and drop IRs within the Impulses list view to
create a copy of the IR in a new index location.*
*NOTE: There are intentionally no options to move or reorder IRs in a
single operation, thereby reducing the risk of unintentionally breaking the
link between IRs and the Helix presets that may be referencing them. Use
the Copy and Clear functions to rearrange IR within the Impulses list as
needed.

•

Transfer To/From Helix Hardware (For Helix/HX Edit application owners)
- With a Helix device connected, drop an IR from the Helix Native plug-in's
Impulses panel directly into the Impulses panel of the HX Edit application. It is
also possible to drag an IR from HX Edit into the Impulses panel of Helix Native
to import a copy of the same IR file.

Loading an IR in an IR Block
When you insert an IR block within your preset's Signal Flow, it initially defaults to
referencing the #1 IR index location (if you have not yet imported any IR file into the
referenced index location, the "empty" IR block has no effect on the signal).
To choose which IR index is referenced by the IR block, select the IR block within the
Signal Flow, then, in the Edit tab, use the IR Select parameter slider (or its menu at the
right) to select the IR index number (1-128) that includes the desired IR.

Choosing an IR by its Library index number within the Edit tab

You can use the other IR block parameter sliders in the Edit tab to further shape the IR's
tone and level - see "Editing Model Parameters" on page 32.
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Working in the Plug-in Editor
To the right of the Librarian panels is the Editor UI of the plug-in, which consists of a top row of options, the Signal Flow and Inspector windows, offering a multitude of options for
adding & configuring processing blocks, signal routing & parameter automation configurations. See the following sections for details on using these user interface elements.
Next/Previous Preset

Preset Name

Preset File Menu

Snapshots Menu

Tempo Controls

Show/Hide
Librarian Button

Signal Flow Window

Edit & Automation/Controller
Assign Tabs

Inspector Window

Navigating with the Next/Previous Preset Buttons

Naming the Preset

The Preset Name field displays the name of the most recently loaded Helix preset.
Double-click on the text here to optionally rename the preset.

These buttons provide an easy way to increment forward and backward within the
current plug-in Library setlist, instantly selecting and loading the preset into the Signal
Flow window. If you wish to have these buttons navigate through a different setlist,
choose the desired setlist from the Setlist menu at the top of the Presets panel.

NOTE: When you edit the preset title or make any other changes to the preset's
settings after initially loading it, be sure to use the Save to Library or Save to
Disk options found within the Preset File menu (see next section) if you wish
to retain your changes within a preset that can be utilized by other Helix Native
instances!
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Using the Preset File Menu

Snapshot Menu

Current Snapshot
Indicator (1 - 8)

To the right of the Preset Name field is the File menu which includes options for the
current tone.
Preset File Menu Button

The Snapshots Menu
•

•

•

•

Open From Disk - Allows you to load a saved preset from your collections
of Helix preset (.hlx) files saved on your computer. This differs from using the
Import command found within the Presets panel in that it loads the preset
directly into the Signal Flow without also importing the preset into the plugin's Presets panel library. If you edit this loaded preset and wish to save your
changes, use the Save options, as described below.
Save To Disk - Exports the currently loaded tone to your computer, offering
you the option for your specific save location. By default, presets are saved as
.hlx files to:
• Mac - /Documents/Line 6/Tones/Helix folder
• PC - \My Documents\Line 6\Tones\Helix folder

•

To Configure and Edit a Snapshot - Click on the Snapshots Menu and select
the snapshot index number you wish to edit, then configure all desired options
for your current tone's block bypass states, tempo and snapshot controller-assigned parameters' values. Your changes are stored automatically for the current snapshot index number. Be sure to Save your tone to permanently retain
your snapshot settings with the preset.
To Load a Snapshot - Simply choose the desired snapshot index number from
the menu and all the settings configured for the snapshot are recalled instantly.

TIP: Snapshots can also be loaded in real-time via your DAW host's plug-in parameter automation functionality - see "Automating Snapshot Changes" on page 38.

Editing the Tempo
There are a few options available for configuring the tempo that is utilized by the plugin, accessible from the controls at the top of the Signal Flow window. Any of the current
tone’s effects blocks that are set to note division values (a Note Sync option is available
for most delay and modulation effects within the Edit tab - see page 32) will follow
this tempo value.

Save To Library - Allows you to choose any preset location within your Presets
panel to save the preset into the plug-in's internal Presets Library.

NOTE: Most host DAW applications also offer their own feature for saving and
loading plug-in presets. The options for this feature are typically found in the
header of the host's plug-in window in which your plug-in instance appears.
This type of feature creates these presets as files on your computer disk and are
not managed by the Helix Native Presets Library. If you open a preset from the
host DAW preset location, it will load within the Helix Native Signal Flow - use
the above described Save To Library command if you'd like to have the preset
added to your Helix Native Presets panel.

Tempo Select Menu

Numerical Tempo Field
& Tap Tempo Button

The Tempo controls

Configuring and Loading Snapshots

How the Tempo Value is Recalled

The Snapshots Menu allows you to load and edit the 8 snapshots available within each
preset, providing instant recall of up to 64 assigned parameter value changes, block
bypass states and more, in one click.

Use the Tempo Select Menu to select how the tempo value is utilized and recalled.
•

NOTE: To follow is a quick description to get you going, but the snapshots
feature is a big enough topic that we've dedicated an entire chapter to it - please
see "Working with Snapshots" on page 23.

•
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Per Snapshot - The tempo value will be stored and recalled individually with
each snapshot (see "Working with Snapshots" on page 23 for details).
Per Preset - The tempo value will be stored and recalled individually with this
preset.

•

Sync to Host - The tempo value follows the timeline tempo of the host DAW
project for any preset loaded within the plug-in instance. Note that even if your
DAW project has timeline tempo changes automated, Helix Native will follow
when using this setting!

Entering a Tempo Value

To the right of the Tempo Select Menu is a combined Numerical Tempo Field and Tap
Tempo Button. When you have selected the Per Snapshot or Per Preset tempo modes
in the menu, you can enter a tempo here in two ways:
•
•

Right-click to type in your desired numerical tempo value.
Click rhythmically to "tap" in your preferred tempo.

Show or Hide the Librarian Panel
Click the button at the top left of the Signal Flow window to either display or collapse
the Presets & Impulses Librarian Panel. Also see "Customizing the Helix Native Plug-in
Window" on page 11.
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Working with Snapshots
Within Helix hardware devices, and within Helix Native plug-in, it is possible to create
& customize up to 8 “snapshots” within a preset. Snapshots can store a set of options
(e.g., a block’s bypass state, up to 64 assigned parameter values, tempo settings and
more), and then recall them without the brief lag time and audible signal drop-out typically associated with changing presets.

The Snapshots Menu

Snapshots > Block Bypass

Configure up to 8 snapshots with your desired settings for the current tone within Helix
Native, and then recall any snapshot from the Snapshots menu, via your DAW host’s
parameter automation, or via external MIDI control (MIDI CC 69, values 0-7). Snapshots
created and exported from Helix devices (via the HX Edit application) are also supported within the Helix Native plug-in, and vice-vera. This all presents some extremely
powerful mix capabilities in your DAW, with the ability to instantly recall and change
numerous Helix Native parameter settings in real-time!

Snapshots automatically store the current bypass (on/off) state for all processing
blocks. Therefore, all block bypass states are recalled when jumping from snapshot to
snapshot, and appear as you last left them.
For example, here's a scenario where you might configure and name snapshots to
toggle the desired blocks on/off for each section of your song.
Snapshot 1—INTRO could have Distortion 1, Amp 1, Cab, Mod 1, and Delay 1 on:

TIP: Don't worry - you actually don't need to utilize or even understand anything
about snapshots if you don't want to right now! You can completely ignore them
and edit your presets without accessing them at all. But if you want to explore the
possibilities, please keep reading this chapter.

Snapshot 2—VERSE could have Dynamics, Distortion 2, Filter, Amp 2, Cab, IR, Delay
2, and Reverb on:

Similar to the snapshots feature in some high-end digital mixers, each Helix Native
snapshot stores and recalls the state of certain elements within the current preset,
including:
•
•
•

Snapshot Menu

Current Snapshot
Indicator

Snapshot 3—BRIDGE could have Dynamics, Amp 2, IR, EQ, Mod 2, and Delay 2 on:

Block Bypass—The bypass (on/off) state of all processing blocks, independent of any footswitch assignments - see "Snapshots > Block Bypass"
Parameter Control—The value of any parameter assigned to a snapshot controller (up to 64 per preset) - see "Snapshots > Parameter Control"
Tempo—The current system tempo, if the Tempo Select is set to Per Snapshot. (By default, it’s set to Per Preset.) See "Editing the Tempo" on page 21.

Snapshot 4—CHORUS could have everything on:

Depending on how you configure them, snapshots can act as 8 variations of the same
tone, eight drastically different tones, or any combination thereof—all within the same
preset.

And Snapshot 5—INTERLUDE could just be Amp 1 and the IR:

The Snapshots Menu

Note that all snapshots in a particular preset share the same models; you cannot, for
example, add a US Deluxe Amp block in Snapshot 1 and switch its model to Essex
A30 in Snapshot 2. However, (if the current Helix Native instance has not reached its
maximum processing limit), you can load both amp blocks into the same preset and
snapshots can enable neither, one, or both of them.

Snapshots are accessed via the Snapshots menu at the top of the Helix Native plug-in
main window. The index number displayed within the little camera icon within the Snapshots Menu tells you which of the preset’s 8 snapshots is currently loaded. Click the
menu to select and load a different snapshot. Ctrl+click / right-click directly within the
menu to rename the current snapshot as desired. Also see "Configuring and Loading
Snapshots" on page 21.
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Snapshots > Parameter Control

2.

In addition, parameters can be set to jump to specific values with each snapshot.
Here’s an example where seven parameters' values (out of a possible 64) are updated
instantly with each snapshot:
Snapshot

Amp
Gain

Delay
Mix

Split A/B

Pitch

IR
Select

Volume
Level

1 INTRO

4.5

35%

Path A 100

0

#27

-7.2dB

2 VERSE

4.5

35%

Path A 100

+5

#27

0.0dB

3 BRIDGE

5.2

43%

Path B 100

+3

#103

+0.8dB

4 CHORUS

4.5

50%

Path B 100

0

#103

+1.5dB

5 INTERLUDE

3.9

8%

Even Split

+5

#27

0.0dB

6 SOLO

8.7

72%

Path B 100

+12

#103

+2.6dB

7 BREAKDOWN

2.0

46%

Path B 47

-12

#12

0.0dB

8 OUTRO

4.5

35%

Path A 100

0

#41

-3.6dB

Assigning the Drive parameter to the Snapshots controller

3.

You’ll see the parameter’s value appear in white and in brackets to indicate the
Snapshots controller assignment.

4.

Now you can simply load any Snapshot and set this Drive slider to the desired
value - the value is independently stored and recalled with each Snapshot.
Each preset can have up to 64 controller assignments, including parameters controlled by Snapshots. Remember to save your tone if you want your assignments
to be permanently stored with the preset!

5.

All existing Snapshots Assignments appear within the Automation/Controller
Assign tab’s Assignment List.

In the table above, we see that when changing from Snapshot 2—VERSE to Snapshot
3—BRIDGE:
•
•
•
•
•
•

In the Edit tab, Right-click on the Amp’s Drive parameter and choose the Snapshots option.

The Amp block’s Gain increases from 4.5 to 5.2
The Delay block’s Mix increases from 35% to 43%
The Split block routes your guitar from Path A to Path B
The Pitch block’s Interval lowers from +5 to +3 semitones
The IR changes from index #27 to #103
The Volume block’s Level increases from 0.0dB to +0.8dB

If desired, you can right-click on the assignment here and choose Clear Assignment to remove it.

If you want a parameter to be automatically updated with each snapshot, the parameter
must first be assigned to a Snapshots Controller, as covered in the next section.

Assigning a parameter to the Snapshots Controller
As covered in the preceding Snapshots > Block Bypass section, the Bypass state of
any block is automatically stored and recalled per snapshot. However, for other parameter types, it is necessary to first create a Snapshots Assignment to allow the parameter’s value to be stored and edited per snapshot.
1.

Once a Snapshots Assignment is created, any changes to the value of the assigned parameter is instantly stored with the current snapshot. These stored
values are recalled when jumping from snapshot to snapshot, and appear as
you last left them per snapshot.

Within the Signal Flow window, select the block which includes the parameter
you wish to control via snapshots. For this example, we’ll choose the Litigator
Amp+Cab block so we can control the amp’s Drive parameter.
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Copying, Pasting & Renaming Snapshots
You can Copy & Paste all snapshot settings from one snapshot to another within the
current tone as a time-saver for when you want to just change a few settings. You
can optionally Rename your snapshots to help you remember the intended purpose of
each. These snapshot commands are available via right-click on the Snapshots Menu.
To Copy & Paste a Snapshot - Select and load the snapshot you wish to copy
and select Copy from the Snapshots right-click menu. Then load the snapshot you
wish to overwrite and choose Paste to paste the clipboard contents, replacing the
currently loaded snapshot.
To Rename a Snapshot - Right-click on the currently loaded snapshot from the
Snapshots Menu and select Rename. Type in your new name, then press Enter/
Return on your keyboard.

Tips for Creative Snapshot Use
•

•

•
•
•
•
•

As in the preceding examples, configure a dedicated snapshot for each section
of your song - Snapshot 1 for the Intro, Snapshot 2 for Verse 1, Snapshot 3 for
the Chorus, and so on. Then use your host DAW's parameter automation to
load the snapshots in real-time!
Worried that further tweaking might make your tone worse, not better? Snapshots are a great way to compare minor changes between tones without losing
your settings.
Turn any Delay or Reverb block's Trails parameter to "On" for seamless spillover between snapshots.
Set different keys in Harmony Delay blocks or intervals in Pitch blocks per
snapshot.
Having difficulty maintaining consistent volume levels throughout a song? Set
the Output block's Level parameter per snapshot.
Recall snapshots via an external MIDI controller device or software using the
dedicated MIDI CC 69 - see "Global Reserved MIDI CCs" on page 40.
Rename your snapshots uniquely within a preset to define their purpose - see
the previous section.

NOTE: All snapshots assignments and settings are retained within the current
tone's preset until another preset is loaded within the plug-in. If you wish to
permanently retain all your snapshot assignments and settings with the preset,
be sure to use the File Menu options to Save your tone to the Preset Library or
to Disk The snapshot that is in use when you save your preset is the one that is
recalled when the preset is loaded again.
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The Signal Flow Window

Adjusting Levels - Just as with all sliders in Helix Native, the Master Input & Output Level sliders can be adjusted in several ways:
•
•

The Signal Flow Window displays the plug-in's inputs and outputs, levels and all your
processing elements, all laid out in the actual flow in which your DAW audio signal is
routed through it. When you click on any input, output or processing block and select it
here, you can then access the block's model & parameter options within the Edit tab,
or its automation options within the Automation/Controller Assign tab below.
Path 1A

Selected Block

Path 1B

Split Block

•
•

Merge Mixer Block

Click on any slider's "handle" and drag to the desired value.
Click on the desired range location within a slider's path and it will jump to the
clicked value.
While hovering your mouse cursor over the slider's path, use your mouse wheel
to adjust it.
Double-click anywhere on the slider area and enter a precise numerical value.

Clipping, as indicated by the Clip Indicator at the top of the meter lighting up red,
should always be avoided for both the plug-in's input and output.*
*TIP: Configuring your input levels into Helix Native is important for achieving the optimal sound from most Amp & Effect blocks. Please see "Optimizing the Input Level" on page 10 for details.
If the plug-in's Output meter is showing very low or high levels, it is best to adjust
the blocks that may be cutting or boosting the signal too heavily (Dynamics, Distortions and Amp blocks, for example, all offer Gain or Volume parameters). However,
you can always use this Master Output Level slider to optimize the plug-in's final
output level.

Master Input
Level

Path 2A

Bypassed Block

Active Block

The Signal Flow Window

Reset to Default Level - Cmd+click (Mac) or Ctrl+click (PC) directly on the Input
or Output slider to reset them to their default (unity gain) value.

Master Output
Level

Peak Level Display - The numerical, real-time peak level value is displayed at the
top of each slider whenever you are adjusting the slider, and whenever you hover
your mouse cursor over the slider path.

Show/Hide Block Labels Option
If you prefer a cleaner look within the plug-in's Signal Flow window, you can "hide" the
descriptive text labels that appear below each block using the Show/Hide option within
the Preferences > General window (see page 42). When set to hide the labels, you'll
only see a block's label appear when hovering your mouse over the block.

Block label option set to Show

Adding, Clearing & Bypassing Blocks
To Add a Block to Your Tone - Hover your mouse cursor over the desired location
on any path and you'll see an empty block location appear to indicate that a processing block can be added there. Once you click and select the empty location,
choose any type of block from the Edit tab's Model Browser. Please see "Selecting Models" on page 31 for more info.

Block label option set to Hide

NOTE: The Show/Hide Labels function affects all Helix Native plug-instances
globally. (However, you may need to close any other currently open plug-in instance's window and re-open it again before a change in this setting is applied.)
Selecting a location in the Signal Flow for a new block

Master Input & Output Level Controls

To Clear any Existing Processing Block - Select the desired block and select
Clear from the block's (Ctrl+click or Right-click) context menu.

At the left and right of the Signal Flow are the Master Input & Output level sliders,
along with real-time level meters. These level sliders' values are not saved per preset
and, therefore, offer independent control over levels entering and exiting the plug-in. To
follow are several tips for using these controls.

To Bypass or Enable any Existing Processing Block - There are a several ways
to bypass or enable a block:
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•

Whenever you hover your mouse cursor over a block type that offers bypass,
you'll see a click-able Bypass/Enable button appear.

*NOTE: Some restrictions apply for Copy / Paste of blocks, depending on the DSP
capacity and features of the particular device in use. For example, just as any Helix
Native plug-in or device preset will prevent adding some block or model types as
the DSP limit is reached, the same DSP limit rules apply for Copy / Paste. Therefore,
Copy and Paste observes these Block rules as well. Physical inputs & outputs differ
between Helix Native and Helix/HX Effects devices, therefore, the copying of Mix, Input
and Output blocks and their settings may not be allowed, as covered throughout this
chapter.

Bypass/Enable button appears above block
•
•

Cut - Clears the block from the Signal Flow and copies the block and its current
parameter settings to the clipboard.*

Select the desired block and select Bypass or Enable from the block's
(Ctrl+click or Right-click) context menu.
Click the Bypass/Enable button offered in the Edit tab - see "Editing Model
Parameters" on page 32.

Copy - Copies the block and its current parameter settings to the clipboard.*
Paste - Pastes the most recently Cut/Copied block into the currently selected
block location within the Signal Flow. If already occupied, this will replace the existing block and its settings.

Cutting, Copying, Pasting & Clearing Blocks

Clear - Removes the selected Amp or Effects block from the signal flow.

It is possible to Cut, Copy, Paste or Clear any individual Amp or FX block, or Clear All
Blocks, within Helix Native. To access these commands, click on the desired block within
the Signal Flow to select it, then Right-click or Ctrl-click to display the context menu.

Clear All Blocks - Removes all Amp & Effects blocks from the signal flow.
*NOTE: When using the Cut command for a block that includes Automation
(Knob or Switch) Controller assignments, the assignments are included in the
settings data when copied to the clipboard and included the first time the block
is pasted into a new location within Helix Native. When using the Copy command, no existing Automation Controller data is copied to the clipboard.
Drag-delete - Another handy way to clear any block is to simply drag the block in any
direction out of the signal path. Once you reach the outer boundary of the path, you'll
see the "Drag-delete..." notice appear, as well as a specific mouse cursor icon that
indicates the block will be deleted once you release the mouse button. (Note that the
mouse icon differs for Mac vs Windows, as shown below.)

Block context menu

It is also possible to use Cut Block or Copy Block and then use Paste Block in either
any Helix Native plug-in instance or the HX Edit application, as follows:
Into any path within the same or a different instance of the Helix Native plug-in,
and within any preset.
• Into any path within the HX Edit app, and within any preset.
• Into any preset within HX Edit when then connected to a different Helix or HX
Effects device (as long as the copied Block data is the last item copied to your
computer's clipboard).
Block Copy / Paste is allowed for all block types (Amp, Effects, Mix, Input and Output
blocks), with some restrictions.* This provides great flexibility in re-creating tones between Helix Native, HX Edit, and even different Helix devices.
•

Drag-delete of a Reverb block (Mac)

Drag-delete of a Reverb block (Windows)
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Block Order and Stereo Imaging

Moving Blocks & Arranging the Signal Flow

Helix Native is a stereo plug-in, with each signal flow path carrying two channels of
audio. When Helix Native plug-in is inserted on a stereo DAW track and fed a stereo
input (or playback of a stereo clip), the left and right audio is processed discretely in
stereo within each path, wherever stereo blocks are used within the path. Whenever a
mono block is added within a path (such as an Amp or mono Effects model), both channels of audio are combined and sent out of the block as mono.

To arrange blocks within a signal path, in addition to using Cut/Copy/Paste (see previous section), you can also click and drag any block left or right to move it to the desired
location. While dragging you'll see an empty block location appear to indicate where
you can drop your block, and existing blocks will move to accommodate it. Each path
can hold a maximum of 8 blocks.

Most of the Helix effects models have both mono and stereo versions. A stereo block
displays
after its model name in the inspector. The stereo imaging—or how wide
your tone appears with stereo monitor speakers or headphones—is highly dependent
on the type of blocks you add and in what order.

Dragging a Delay block - an available empty block location appears while dragging

Legacy effects models vary in behavior, just as on the classic Line 6 effects from where
these models originated.
•
•

•

To follow are a number of pointers for arranging the signal flow in different ways.

Legacy Distortion, Dynamics & Pitch/Synth effects are mono.
Legacy Modulation & Delay effects vary in that some are mono, some stereo,
and some mono-in/stereo-out, where adjusting the effect's Mix parameter can
narrow the stereo image that is fed into them. It is best to experiment with
these effects and tweak the Mix parameter to achieve the desired stereo output
results.
Legacy Filter and Reverb effects are stereo.

Split Paths - Drag a block down from the main signal path (Path 1A or Path 2A) and
you'll see a parallel, split path (Path B) appear, with both a Split and Merge block
created at each end. To remove the split path, clear or move all blocks out of the
parallel path. Alternatively, you can Right-click on the Split or Merge blocks and
use the Create Input/Output or Restore Split/Merge commands instead of dragging.
TIP: It is possible to drag and drop an Amp & Effects block between Split
Paths 1A and 1B, or between Split Paths 2A and 2B, but it is not possible to
drag and drop a block between Paths 1 and 2. You can use a block's Cut,
Copy and Paste commands (see previous section) to arrange your blocks
between these Paths.

Keep the following things in mind when building tones:
•

•
•

•

•

All Amp+Cab, Amp, Preamp, single Cab and IR blocks are mono, so any stereo
signal sent into these will be collapsed to mono. As such, it’s a good idea to add
only mono blocks before amps and preamps to conserve computer processing
resources.
Adding a mono effects block will collapse any preceding stereo blocks' signal
on the same path to mono.
The Helix Native plug-in's signal flow always allows the use of mono or stereo
type processing blocks, regardless the type of track on which it is inserted.
This allows you to utilize any existing preset and create complex routings within
the plug-in Signal Flow (see the routing examples later in this chapter). When
inserted on a mono output track, the output at the end of the Helix Native signal
chain is summed to mono.
If you’re using Helix Native on an audio track with mono input and output, there
is no need to use stereo models at all (except, of course, for models that are
only offered as stereo).
Stereo models use twice as much processing resources as mono models,
therefore, its a good idea to only utilize stereo models when stereo processing
is desired.

Split and Merge Blocks - When a Split block is selected in the Signal Flow, you
can choose from among 3 types of Split blocks and adjust its balance options using the parameter sliders that appear in the Edit tab below.
Input & Output Blocks - A path's Input and Output blocks cannot be moved, but
when you select one of these blocks, you'll see options within the Edit panel below
- please see "Editing Input, Output, Split & Merge Blocks" on page 33.
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Signal Routing Examples

Discrete Stereo Processing with Amps

To follow are a few more routing possibilities you can try within the Signal Flow. Also be
sure to try some of the factory presets we've provided within the TEMPLATES/OTHER
setlist for even more configurations.

As mentioned in "Block Order and Stereo Imaging" on page 28, each path within
the plug-in is capable of processing discrete left & right audio input on a stereo
Audio, Aux or Bus track, provided you're utilizing all stereo blocks on the plug-in's
signal paths. But if you're wanting to utilize any Amp or Preamp blocks (which are all
mono-output blocks), it is necessary to split the path to allow the left & right audio
channels to be processed discretely.

1 into 2

Drag a split path's Merge block down to Path B. The Merge block shifts right and
a duplicate Output block is created:

Start with the AUX: DiscreteDuo preset provided within the factory TEMPLATES/
OTHER setlist. This preset already has all necessary routing configured for discrete
stereo using an amp on each path. To follow are the key settings for this signal flow.

In this example, the input signal is split to stereo Paths A and B, each with its own
Output block. You can now use Path A and B's Output block options to independently pan each left/right as desired.

1.

A Split Y type block is used with its Balance A & B parameters panned hard
left and right.

2.

The Merge block's Pan A & B parameters are set hard left and right, respectively, to also keep the two channels' audio discretely separate.

3.

The Path 1 Output block is fed to Path 2A, allowing additional stereo effects
blocks to be applied.

Split Y block Path 1A (with mono blocks) Path 1B (with mono blocks)

Parallel Paths

Merge block

If you start with a split path, you can convert it into two individual, stereo parallel
paths, each with its own Input and Output block.
1.

Drag the Split block down to Path B (or Right-click on the Split block and
choose Create Input). The Split block shifts left and a duplicate Input block
is created.

2.

Drag the Merge block down to Path B (or Right-click on the Merge block and
choose Create Output). The Merge block shifts right and a duplicate Output
block is created.
Inactive Split block

Path 2A (with stereo blocks)
In this configuration, Path 1A of the split path will process only the left signal,
and the Path 1B will process only the right signal, allowing you to add mono
blocks on each of these parallel paths accordingly.

Inactive Merge block

By placing stereo blocks on Path 2, it will still retain the left/right channel
separation, allowing you to use common effects to save some resources.

Once converted to Input & Output blocks, the Split and Merge blocks become inactive - you can drag the Split and Merge blocks up to the Path A above (or Right-click
on the Split or block and choose Restore Split or Restore Merge) to revert back to
a Split Path configuration.
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Tips to Optimize Processing Power Usage

Super Serial

•

A serial path has eight processing block locations. If that’s not enough, you can use
parallel Path B to create an extended “super serial” path configuration.
1.

Drag the Merge block down to Path 1B. A duplicate Output block is created.

2.

Drag the Split block all the way to the right, past the last processing block
on path 1A.

3.

Select the Output block on path 1A and turn Knob 2 (Level) all the way down.
That way, you’re only hearing Output 1B.

•
•

•

•

In the illustration above, our signal is processed by the eight blocks on Path 1A and
processed further by Delay block (or whatever blocks you wish to add) on Path 1B.
Of course, if this still isn’t enough, you could always duplicate the above signal flow
routing on Path 2 and then route Path 1B’s output block to Path 2A for one gigantic
serial tone with up to 32 block locations (plug-in processing limit permitting - See
"Computer Processing Management" on page 14):

•
•
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Some block types, such as Amps, Cabs, IRs, and Pitch Shifters, use much
more of your computer's processing power than others. Not surprisingly, the
Amp+Cab block uses the most. EQ, Dynamics and Volume/Pan blocks use
relatively little.
Some models may require more processing power than others of the same
category. This is especially true with Amp models.
If you run out of processing power on Path 1, route it to Path 2 for more horsepower (see "Computer Processing Management" on page 14). If creating
tones with two or more amps and more than a handful of effects, use both paths.
Instead of a parallel path with two Amp+Cab blocks or two separate Amps and
Cabs, try adding a single Amp block followed by a single Cab > Dual block
(mixing two different Cabs can provide some substantial variations).
The stereo version of an effects block will use roughly twice as much processing power as a mono version of the same block. Likewise, the dual version of
a cab block will use roughly twice as much processing power as the single
version. Therefore, you likely won't want to use stereo versions of blocks in
routing configurations where they don't actually provide a stereo output (see
next section).
Some model categories have “Simple” blocks, which utilize less processing
power than others.
The "Legacy" type models typically utilize less processing resources than other
models of the same effect type.

The Edit Tab

For block categories that offer it, you'll see a Sub-Category menu at the top of the
Model List, where you can choose to see Mono, Stereo or Legacy type models. Amp
categories offer Guitar & Bass sub-categories, and for Cabs you'll see Single & Dual subcategory options.

The Inspector window's Edit tab provides access to all models via its multi-level Model
Browser, where you can choose from numerous categories of models to make up your
tone. This panel also displays all available parameters for the block that is currently
selected within the Signal Flow window, providing easy access for editing. Be sure
to check out the "Model Lists" chapter for the full array of models and what they are
based on.

Once you click on any model in the Model List it is instantly active and loaded into the
selected Signal Flow location. (You can click on models here to preview them in realtime as your DAW track is playing.) When a model is selected, its editable parameters
appear at the right of the Edit panel. If you want to remove an existing block, select it
within the Signal Flow and choose the None category's Empty Block option. Or, alternatively, Right-click on the block within the Signal Flow and choose the Clear command.

Selecting Models

Availability of Models within the Model Browser

As mentioned in the previous chapter (page 26), add models to your current preset
by selecting the desired empty location on any path within the Signal Flow window and
then choose your specific model from the Model Browser. You can also select any existing block within the Signal Flow and change its model this way. (Also note that if you
select an Input, Output, Split & Merge block, the Model Browser can also offer options
for these block types.)
List/Grid View Toggle

There are cases where some model types are displayed as "dimmed" and not selectable within the Model Browser. There are limits for how many of some types of models
can be inserted within a path and/or within a preset, as described below.

Sub-Category Menu

Dimmed
models
Unavailable models appear dimmed within the Model Browser

Amp+Cab, Amp, or Preamp blocks Any combination, up to four within a preset
(up to two per path)
Cab blocks (includes Amp+Cab Up to four (two per path; Cab > Dual blocks
blocks) are considered two)
Impulse Response blocks Up to four 1024-point IRs (two per path) or
two 2048-point IRs (one per path)
Category List

Model List/Grid

Send/Return & Looper blocks Send, Return, FX Loop and Looper type
blocks remain "disabled" since they are only
functional in Helix hardware and, thus, cannot
be added from within the Helix Native Model
Browser (see page 12 for details).

Parameter Sliders

The Edit tab's Model Browser

Choose the type of block first in the Category List at the left and you'll see all of its
available models appear in the Model List. Note that, once you've selected a Category,
you can toggle List/Grid View Toggle button to change between a list or grid display
of the category's models.

Model List view

Additionally, as per the computer processing management functionality of Helix Native
(see page 14), when the current tone approaches its allowable processor usage limit,
some models may not be selectable if adding them would result in the tone exceeding
the limit. To free up more resources for the current preset, try removing some models, or
swapping out models with similar mono or "simple" versions within the same category.

Model Grid view
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Editing Model Parameters

Configuring a Parameter for Host DAW Automation - Right-click on a slider to
display the menu of Automation Controllers, which allow the host DAW application
to access the parameter for its automation features - see "The Automation/Controller Assign Tab" on page 34 for details.

Once added to your tone, simply click on any block within the Signal Flow to select it
and you'll see the model category and type highlighted in the Model Browser, with its
parameter sliders available at the right of the Edit tab.
Model Browser

Edit Tab

Selected Model Stereo Indicator

Accessing All Parameters - Note that some model types, such as amps and
complex effects, may have more sliders and controls than you can see all at once
in the Edit tab. Click and drag the vertical scroll bar at the right to access all parameters (or use your mouse wheel when hovering your mouse cursor over the
scroll bar). You can also resize the entire plug-in window as desired by dragging its
bottom right corner.

Bypass/Enable

Note Sync
Most modulation and delay effects models offer a Note Sync option, allowing the modulation rate or delay repeat time to follow the plug-in's main tempo value. For models
that offer it, you can click the Note Sync button within the Edit tab to toggle the feature
on/off. When active (the Note Sync button is lit), the parameter will change to offer note
division values, as shown below.

Parameters

The Inspector Window - Edit Tab

Note value options

Selected Model, Stereo Indicator- At the top of the parameter pane you'll see
the name of the selected model. If the selected model is stereo, the
indicator
appears to the right of its name, as pictured above.
Bypass/Enable - For all block types that support it, the Bypass/Enable button at
the top right allows you to manually toggle the block's processing on or off. Note
that you'll see all the block's parameter sliders become "dimmed" to indicate the
bypassed state. Alternatively, hover over the block and use Right-click or Ctrl+click
to choose the bypass/enable options from the context menu - see "Adding, Clearing & Bypassing Blocks" on page 26.

Tempo Sync (active)

A Delay block configured for Note Sync

Adjusting Parameter Sliders - There are several ways to adjust slider values:
• Click on any slider's "handle" and drag to the desired value.
• Click on the desired range location within a slider's path and it will jump to the
clicked value.
• While hovering your mouse cursor over any slider's path, use your mouse wheel
to adjust it. (Note that hovering over the scroll bar at the right also allows you
to use the mouse wheel to scroll vertically when there are more parameters.)
• Click the up/down arrow buttons at the right for incremental adjustments. If a
down arrow is displayed at the right, click on it to expand a menu of selectable
options.

The plug-in tempo value that the Note Sync follows can be either be manually defined
or set to follow your host DAW project's timeline tempo, via the plug-in Tempo Controls
(see "Editing the Tempo" on page 21).

Resetting Sliders - If you're not happy with your slider adjustment, use Cmd+click
(Mac) or Ctrl+click (PC) on a slider to reset it to its initial default value.
Type in a Precise Value - Double-click anywhere on a slider's path, or on its value,
to manually type in a precise numerical value.
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Editing Input, Output, Split & Merge Blocks
Just as with Amp & Effects blocks, you can click on these block types within any Signal
Flow path and access their options in the Edit tab.
Input Block Options - The Input block for any path (except Path 1A) is able to
be set to receive input from the Host or None. If you have configured the Output
block of a preceding path to feed into the current path, then you may wish to set
the current path's Input block to None so that it does not also receive input audio
from your Host DAW track. All Host Input blocks include a built-in Noise Gate, and
you'll find the Gate's On/Off and parameter sliders here as well.
Output Block Options - Path 1's Output block offers options to feed the path's
output to Host, or into any existing Input block of Path 2. (If you've created a separate Path 1B, its output block offers these options as well).*
Path 2's Output block is always routed to Host.
All Output blocks offer Pan and Level sliders here within the Edit Tab.
*TIP: See page 28 for info about creating different possible path routing
configurations using these Output block options.
Split Block Options - If your preset includes a Split path, click directly on the point
of the main path where the signal divides to select the Split block and you'll see options for choosing different Split block types and their parameters. Note that there
is also a Bypass switch for Split blocks which, when bypassed, results in the block
feeding an equal signal balance to each parallel path.
Merge Block Options - If your preset includes a Split path, click directly on the
point of the main path where the signal returns to select the Merge block and you'll
see several mixer options for blending the two paths' signals.

Editing Send, Return, FX Loop & Looper Blocks
These block types are supported only by Helix hardware devices, therefore, you'll only
see them within Helix Native when importing a Helix preset that was exported from
a Helix device. When included within a Helix Native tone, they are displayed with a
slashed circle icon on the block to indicate this "unsupported" state.* However, you can
still move & clear these blocks within the Signal Flow, and edit the parameters of these
blocks within the Edit tab. Your edits are retained within your exported presets for use
on Helix devices - see "Preset Compatibility with Helix Devices" on page 12.
*NOTE: If an existing Send, Return or FX Loop block is toggled as "active" via its
Bypass switch, it can reduce or fully mute the path's audio signal, depending on
the block's Mix or Dry Thru parameter settings. To ensure these block types are
not affecting the plug-in's signal path, simply toggle the block as bypassed.
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The Automation/Controller
Assign Tab

Controller Assignment for Automation
Since Helix Native can potentially include numerous parameters (depending on how
many Amp & Effects blocks you add within your tone), Helix Native utilizes a set of assignable controllers that allow you to map whichever sliders and switches you desire
to automate. To follow are what will appear as "automatable" Helix Native parameters
within your host DAW application's plug-in automation menus.

The Inspector window's Automation/Controller Assign tabbed panel is where you
can create, edit and reference all your automation controller assignments for the current
plug-in instance. This panel offers two sections - the Assignment List at the left where
all current assignments are shown, and the Inspector at the right where you can create
new automation assignments and access additional options for existing assignments.
Assignment List

Column Headers

Selected Block

•
•
•

Target Parameter Menu

•

Selected Assignment

Min/Max Range
Parameters

The Automation/Controller Assign tab

Knob 1-16 Controllers - Allow you to assign “variable” type controls - for example, the Mix slider of a delay, or the Drive slider of an amp.
Switch 1-16 Controllers - Allow you to assign “Off/On” switches, such as the
bypass switch for any block.
Snapshot Index Controller - Allows you to automate the loading of any of the
current tone's 8 Snapshots.
Additional "Fixed" Controllers - These Helix Native global parameters are already mapped and require no automation controller assignment: Master Input
Level, Master Output Level, and Master Bypass. (Note that some host DAW
applications also offer their own "fixed controllers" within their automation
menus that are also usable with Helix Native plug-in, such as a Wet/Dry Balance or their own plug-in Bypass.)

Creating an Automation Controller Assignment

Automation Controller
Menu

Before you’ll be able to utilize your DAW host’s track automation for a Helix Native parameter, it is necessary to first assign the desired parameter to an automation "Knob"
or "Switch" controller. This is performed as follows.

About Plug-in Parameter Automation

Automating a Variable (Slider) Parameter:

Helix Native supports your host DAW application's features to read, write and edit parameter automation, where the DAW can control the plug-in's parameter values over
time using editable track envelopes. Helix Native takes this concept even further and
not only allows for practically any block's parameters to be automated, but also allows
automating the loading of any of the current preset's Snapshots, which effectively provides simultaneous switching of numerous Helix Native parameters in one action!
Most DAWs additionally allow you to record parameter automation in real-time, where
you enter an automation “write” mode and changes to the selected plug-in parameters
are recorded and displayed on the track as adjustable envelopes. This allows all these
parameter changes to be played back (using the host's track "read" mode option) and
incorporated into your project’s mix-down.

1.

Click on the block within the signal flow that contains the model and parameter
that you wish to automate. For this example, we'll create a controller assignment
to automate the Mix slider of the Simple Delay model.

2.

In the Automation/Controller Assign tab, you'll see that the Simple Delay block
name is displayed at the top, indicating that it is the selected block. Click on the
Target Parameter menu to see all of the Simple Delay's parameters - select the
Mix parameter.

Host DAW applications typically allow you to access the list of automatable parameters
for a plug-in by way of an automation parameter menu, specific to the audio or aux
track where you have inserted the plug-in. Each host DAW software offers parameter
automation options slightly differently, so it is recommended that you consult your host
software’s documentation for its specific instructions and parameter automation capabilities.
Selecting a Delay's Mix as the target parameter for automation assignment
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3.

Once a target parameter is selected, click on the Automation Controller menu
and select the "Knob" controller to which you want to assign your selected target parameter. We will select Knob 1. (You can optionally assign a slider to one
of the Switch automation controllers to allow the parameter to be automated
strictly between two defined values - see the Tip at the end of this example.)

6.

You should be able to see an envelope line for the "Knob 1" parameter for the
track (your host app may require that you toggle an option to display it). Adding
edit points and adjusting this envelope will now directly adjust the assigned Mix
slider of the Simple Delay.

Cubase Pro with Helix Native "Knob 1" automated on an audio track

Selecting a Knob automation controller for a target parameter

You can repeat these steps, choosing other "Knob" controllers, to create additional automation assignments for the Simple Delay (or any other selected block
within the Signal Flow), if you wish to automate more parameters for this Helix
Native plug-in instance.

TIP: As an alternative to steps 2 & 3, you can Right-click directly on the
Simple Delay's Mix slider within the Edit tab and choose the desired Knob
controller there.

TIP: Alternatively, in step 3 you can choose one of the Switch 1-16 automation controllers, which configures the parameter to be automated strictly
between two specific values. You can define the two values within the Automation/Controller Assign tab using the assignment's Min Mix & Max Mix
value options - see "Editing Options for an Existing Automation Controller
Assignment" on page 37.
Creating an automation assignment from a slider's context menu in the Edit tab

Also note that only one parameter can be assigned to any one Knob automation controller at a time - choosing a controller with an existing assignment
(as indicated by a dot to its left within the Automation Controller menu) will
replace the existing assignment. Or, you can choose None to remove an
existing assignment.
4.

As shown above, a variable Mix parameter slider is assigned to a Switch
automation controller, with its Min and Max Mix values set for 20% and 50%
- these are the two specific values to which the host track automation can
be toggled between.

Once the assignment is created, you'll see it appear in the Assignments List at
the left. When selected in this list, you can edit its assignment settings at the
right of the tab - see "Editing Options for an Existing Automation Controller Assignment" on page 37. You'll also see an automation assignment Knob indicator (or Switch indicator, depending on which type of assignment you created)
displayed for the parameter's slider within the Edit tab, which includes the Knob
number to which it is now assigned:

An automation assignment indicator for "Knob 1" appears at the left of the assigned slider

5.

Now access your host DAW app track's automation parameter menu and select
the Helix Native - Knob 1 to configure it for host automation.
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Automating an Off/On Switch Parameter:
The Switch 1-16 automation controllers are for parameters that offer only a two option
switch. Most commonly this would be a block's Bypass Off/On, but you can automate
other switch parameters in the same way, such as the Speed - Fast/Slow switch of a
rotary speaker model. For the following example, we'll configure the Bypass of a Simple
EQ block.
1.

Add a Simple EQ block to your Signal Flow and click on it to select the block.

2.

In the Automation/Controller Assign tab, you'll see that the Simple EQ block
name is displayed at the top, indicating that it is the selected block. Click on the
Target Parameter menu to see all of the EQ's parameters - select the Bypass
parameter.

4.

Once the assignment is created, you'll see it appear in the Assignments List
at the left. When you select an existing assignment in this list, you can edit its
settings at the right of the tab - see "Editing Options for an Existing Automation
Controller Assignment" on page 37.

5.

Now access your host DAW app track's automation parameter menu and select
the Helix Native - Switch 1 parameter to configure it for host automation.

6.

You should be able to see a "Switch 1" parameter envelope line for the track
(your host app may require that you toggle an option to display it). Adding edit
points and adjusting this envelope will now directly toggle the bypass state of
the assigned Simple EQ block. Note that, since this is a "switch" type parameter,
its track envelope will only create edit points as "off" (0% value) or "on" (100%
value).

Selecting Bypass as the target parameter for automation assignment

3.

Once the Bypass target parameter is selected, click on the Automation Controller menu that appears and select the Switch controller to which you want to
assign your selected target parameter. We will select Switch 1.
Reaper 5 with Helix Native "Switch 1" automated on an audio track

You can repeat these steps, choosing other "Switch" controllers, to create additional automation assignments for the Simple EQ (or any other selected block
within the Signal Flow), if you wish to automate more parameters for this Helix
Native plug-in instance.
Selecting a Switch automation controller for a target parameter

TIP: You can also utilize a Switch automation controller for an automation assignment to a "variable" Helix Native parameter, such as any model's slider
parameter, allowing you to define two specific parameter values to toggle
between when automating the Switch's "Off/On" states - see "Automating a
Variable (slider) Parameter:" on page 34.

TIP: As an alternative to steps 2 & 3 for assigning block Bypass, you can
Right-click or Ctrl-click directly on the EQ block within the Signal Flow and
choose the desired Switch controller from the Automation Bypass menu.

Also note that only one parameter can be assigned to any one Switch automation controller at a time - choosing a controller with an existing assignment (as indicated by a dot to its left within the Automation Bypass menu)
will replace the existing assignment. Or, you can choose None to remove an
existing assignment.
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Editing Options for an Existing Automation
Controller Assignment
Once you've created one or more Automation Controller assignments, they are displayed in the Assignment List at the left of the Automation/Controller Assign tab. This
list makes it easy to reference all your automated parameters and edit their available
options. The Assignment List includes 3 columns:
•
•
•

An Amp - Drive "Switch" automation assignment with its Min & Max (Off/On) values defined

Block - Displays the name of the parent block which includes the assigned
parameter.
Parameter - Displays the name of the assigned parameter.
Source - Displays the automation controller source (Knob 1-16 or Switch 1-16)
to which the parameter is assigned.

TIP: Some DAW hosts also offer additional on-screen controls to provide easy
access to track and plug-in parameters, such as the "Smart Controls" in Logic
Pro or the "Quick Controls" in Cubase Pro. Typically these types of DAW controls
can be set to the Helix Native Knob 1-16 or Switch 1-16 Automation Controllers,
for which you'd want to follow the preceding steps to assign your preferred Helix
Native parameter to the respective Automation Controller.

TIP: Note that you can click on these column titles at the top of the list to sort the
list by Block, Parameter or Source, ascending or descending.

Removing or Replacing an Existing Automation
Controller Assignment

When you click on any assignment within the list, you'll see the assignment's editable
options appear at the right of the Automation/Controller Assign tab. Most variable type
parameters offer Minimum Value / Maximum Value sliders which allow you to customize the automatable values.

To Remove an Existing Automation Controller Assignment - Select the assignment within the Assignment List and choose the None option from the Automation
Assignment menu.

If the Automation Assignment Source is a Knob Controller - The Min & Max
values define the range for which the parameter can be adjusted, allowing you to
limit the range, if desired. For example, if you want an amp's Drive parameter to
automate strictly between the value range of 3.0 to 7.5, set these sliders accordingly, as shown below.

Select None to remove an existing assignment

To Replace an Existing Automation Controller Assignment - Select the existing
assignment within the Assignments List and choose a different Knob or Switch
controller from the Automation Controller menu. This removes the existing controller and applies the newly selected Knob or Switch automation controller to the
parameter.* You can then choose this newly assigned Knob or Switch controller
from your DAW track's parameter automation menu to automate it.

An Amp - Drive "Knob" automation assignment with its Min & Max (range) values defined

NOTE: For Automation assignments, (unlike with MIDI assignments) the Min and
Max values cannot be inverted.

*NOTE: In the case where you have written automation for an existing Helix
Native assignment and performed the above replace action, the automation envelope in your DAW track will be left "orphaned," since the Knob or
Switch automation controller it was configured to automate no longer references any actual Helix Native parameter. If you assign another parameter to
this automated Knob or Switch controller, the track automation envelope will
then control the newly assigned parameter - or, you may wish to delete the
unused automation envelope from your host project.

If the Automation Assignment Source is a Switch Controller - The Min & Max values
define the "Off" and "On" values to which the parameter can set, allowing you automate
switching between these values. For example, if you want an amp's Drive parameter
to automate strictly to either 4.0 or 8.5, set these sliders accordingly, as shown in the
following image.
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To Re-assign an Existing Automation Controller Assignment to a New Parameter - If you choose a new, unassigned block parameter in the Automation
menu, and then select a Knob or Switch from the Controller menu that is currently
assigned to another parameter, this removes the controller assignment from the
existing parameter and assigns it to the newly selected parameter. (Any Knob or
Switch automation controller can only be assigned to one parameter at a time.)

1.

Automation Assignment Preservation when Changing
Models

Access your host DAW app track's automation parameter menu and select the
Helix Native - Snapshot Index option.

Selecting the Snapshot Index automation option in a Logic Pro track's automation menu

You may wonder, once you've configured one or more parameters of a particular Amp or
FX block with automation assignments, what happens to these assignments if you want
to then change the model for this block? For just this situation, Helix Native incorporates an automatic "preservation" for automation assignments, which can intelligently
re-assign the automation assignments when the new model offers similar parameters.

2.

For assignments to be preserved, the assigned parameters of the newly selected model
need to be similar in type and in scale. For example, if you've configured the Drive slider
of the Amp+Cab model to be automated by the Knob 1 automation controller, you can
then select most any other Amp+Cab, Amp or Preamp model for the block and the
Knob 1 controller will automatically re-assign itself to the Drive slider of the new model.
Likewise, if you have a Delay's Mix parameter automated, the Mix parameter assignment will typically be preserved for the Mix parameter of most any other type of FX
model that includes a Mix slider.

You should be able to see a "Snapshot Index" automation envelope line added
for the track (your host app may require that you toggle an option to display it).
Adding edit points and adjusting this envelope allows you to choose the Snapshot 1-8 that you wish to be loaded over the specified time duration.

The editable Snapshot Index envelope line displayed on the Logic track

Feel free to continue to add, edit or remove the specific items you have included
within each of your 8 Snapshots. This automation feature simply loads whichever Snapshot you set it to load, allowing you to continue to customize Snapshots'
contents as desired.

For the cases where automation assignments cannot be preserved automatically, (e.g.,
when a block's model is changed to one with a very different set of parameters) any
existing track envelope with written or edited automation will be left in an "orphaned"
state on your DAW track. But you can manually re-assign the automation controller, as
covered in the previous section.

Writing Parameter Automation
Most host DAW apps also provide several "Read/Write" modes for parameter automation, which typically appear as a set of options on the track (Off, Read, Write, Latch,
Touch, etc.).

Automating Snapshot Changes
As covered on page 23, the Snapshot feature allows you to store a number of settings, such as block bypass, parameter values, tempo values and more, and then recall
all Snapshot-assigned settings simply by loading the respective Snapshot via the plugin's Snapshots menu. For even more flexibility, Helix Native also allows you to automate
the loading of Snapshots 1-8 in real-time using your host DAW application's automation features! Use the following steps to configure a Snapshot automation assignment.

The track automation Read & Write mode options in Pro Tools

When set to Read (typically the default), the track will actively "play back" the automation envelope settings on the track, and when set to Off it will ignore the automation
envelope.
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When one of the Write options is set as active on the track, you can then play the
track and manually adjust any Helix Native switch or slider within the Edit tab that includes an automation controller assignment, and your moves are recorded to the track
in real-time. Also, since the Helix Native Snapshots feature has a dedicated automation
parameter (Snapshot Index), the loading of snapshots via the Snapshots menu can
also be "written" using your host's Write features. Typically you'll see the parameter's
envelope in the track edited with the adjustments that you have written, and you can
manually drag individual edit points to edit the envelope further as desired once playback is stopped.

2.

Go to the plug-in's Automation/Controller Assign tab. If not already selected,
choose the Compulsive Drive's Bypass from the parameter menu at the top
right of the tab.

3.

Click on the menu beneath and choose MIDI In as your assignment type. (If the
Bypass parameter already includes an existing assignment, choose None from
the menu to remove it, then choose MIDI In.)

4.

Use the MIDI In slider to configure the MIDI CC number to which the block's
Bypass parameter will respond - we've select CC 13. Be sure to also configure
your external MIDI device to transmit this same MIDI CC number.

Note that once a parameter is assigned to a controller and automated by the above
methods, it is no longer then possible to manually make adjustments directly to the
parameter's slider or switch within the Helix Native plug-in window, since it then responds only to the written automation envelope values. To edit the settings, either edit
the automation envelope, or utilize one of the host's automation Write modes to make
the desired parameter value changes.

Configuring the MIDI In CC number for a MIDI Bypass Assignment

MIDI Bypass & Controller Assignment

Once configured as above, when a MIDI CC Toggle message (CC 13 with two
alternating values, where one is 0-63, and the other 64-127) is sent to the plugin, it will switch the block's Bypass parameter.

Most parameters and functions within Helix Native can also be controlled remotely
via external MIDI control devices or MIDI software applications. For most Helix Native
parameters, this is accomplished by creating a MIDI CC Bypass or MIDI In Controller
assignment, as shown in the following steps. (Note that several MIDI CCs are reserved
or pre-assigned to Helix Native global functions - see "Global Reserved MIDI CCs" on
page 40).

5.

To remove a MIDI Bypass assignment, Right-click or Ctrl-click on the assignment within the Assignments List at the left and choose the Clear option.
Feel free to continue to add, edit or remove MIDI Bypass assignments for additional blocks as desired. Be sure to Save your tone to retain these assignments
within the preset.

TIP: If you happen to own a Helix device, it makes an excellent MIDI Controller
device for your DAW! Check out the "Command Center" chapter within your
Helix Owner's Manual for details on how to configure the Helix to transmit a
variety of MIDI control messages.

6.

NOTE: You may need to configure your DAW host application to receive MIDI
Control input from your external MIDI controller device or software. These settings are typically found within the DAW application's Preferences. Additionally,
it is often necessary to configure your DAW host track routing to so that the
external MIDI Controller data is fed directly to your current Helix Native plug-in
instance. This often requires the use of a MIDI or Instrument track to receive the
MIDI input and then send it to the audio track on which the Helix Native plug-in
inserted. Please see your application's documentation for details.

Alternatively, you can Right-click or Ctrl-Click directly on the desired Amp, Effects or Mix block within the plug-in's Signal Flow and select MIDI Bypass >
MIDI In to create the MIDI Bypass assignment. Follow step 4 to then configure
the MIDI CC for your assignment.

Creating a MIDI Bypass Assignment
For any block type that includes a Bypass parameter, a MIDI Bypass Assignment can
be created to allow the block's Bypass to be toggled via MIDI CC.
1.

Creating a MIDI Bypass assignment within the Signal Flow

Click on the desired block within the plug-in's Signal Flow to select it. For this
example, we've selected a Compulsive Drive Distortion block.
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Global Reserved MIDI CCs

Creating a MIDI Controller Assignment
Practically any parameter within Helix Native can be controlled remotely via a MIDI
controller device or MIDI software. This can be configured by creating a MIDI Control
Assignment to allow the parameter to be controlled via MIDI CC. For this example,
we'll select the Vetta Wah to be controlled via a MIDI expression pedal.
1.

Click on the Wah block within the plug-in's Signal Flow window to select it,

2.

Within the plug-in's Edit tab, Right-click or Ctrl-click directly on the Wah's Position slider and choose Controller Assign > MIDI CC to create a MIDI Controller
assignment for the parameter.

Helix Native has reserved specific MIDI CC messages which are not available within
Helix Native's menus for creating MIDI Bypass and Control Assignments. As shown
in the following table, most of these reserved MIDI CCs are for features that are only
functional on Helix hardware, but are reserved within Helix Native to provide preset
compatibility with Helix devices.
GLOBAL RESERVED MIDI CCs
MIDI CC# Value

Function

1
2
49
50
51
52

Creating a MIDI Controller assignment for a parameter

3.

Go to the plug-in's Automation/Controller Assign tab and you'll see your newlycreated Wah MIDI Controller assignment in the list at the left. Click on this assignment to select it.

4.

Choose the desired MIDI CC number using the MIDI In slider in the right pane we've selected CC 10. Be sure to also configure your external MIDI expression
pedal to transmit this same MIDI CC number

53
54
55
56
57
58

Reserved for use with Helix hardware assignments

59
60
61
62
63

Creating a MIDI Controller assignment for a Wah

5.

65

If desired, you can adjust the Min & Max Position parameters to limit the range
of a MIDI CC-assigned parameter. Note that it is possible to make the Min value
larger than the Max value,if you want to invert the behavior of the parameter.

66
67

Once configured as above, when a MIDI CC 10 message (with values of 0-127)
is sent to the plug-in, it will control the Wah block's Position parameter.
6.

0

To remove a MIDI Controller assignment, Right-click or Ctrl-click on the assignment within the Assignments List and choose the Clear option.

32
64

Feel free to continue to add, edit or remove MIDI Controller assignments for
additional parameters as desired. Be sure to Save your tone to retain these assignments within the preset.

68
69

40

0-7

Snapshot 1-8 select

GLOBAL RESERVED MIDI CCs
MIDI CC# Value

Function

70
71
72
73

Reserved for future use

74
75
76
128

0-63: Oh;
64-127: Nooo

Helix Native achieves self-awareness and starts poking
fun of that face you make during the solo
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Preferences and Account
Settings

General Screen

The General settings screen offers options for the plug-in's Preset and IR Libraries.
These settings are global and affect current and future instances of the plug-in.
Preset Numbering Format - The presets within the Librarian's Presets Panel can
be numbered as bank numbers & letters (as 01A-32D) or sequentially (as 000-127)
within each Setlist, depending on which is more convenient for you.

The "gear" button at the bottom left of the Helix Native plug-in window provides access
to the menu to open the Preferences window, as well as to several options for managing your Line 6 account options.

Stereo IR Import - When a stereo IR file is imported by Helix Native, it is converted
to mono. This preference lets you choose whether to take the left or right channel
of the source IR file, or to sum both channels to mono. The default is to import the
left channel.
Remove Unsupported Blocks on Import - Presets exported from Helix hardware
can potentially include Send, Return, FX Loop and/or Looper type blocks, all of
which are unsupported block types within Helix Native plug-in (see page 12). Enabling this option automatically strips out these block types from presets whenever
importing Helix Presets, Setlists or Bundles into Helix Native.
Show/Hide Block Name Labels - If you prefer to have the Signal Flow window not
show labels beneath each block, you can choose Hide Names here (see page 26).

The Preferences & Account Settings menu

Clear & Restore Library Options

The Preferences Window

This group of buttons within the window offer quick and easy ways to clear out or restore the contents of the Librarian's panels.

Select Preferences from the menu to launch the Preferences window, which includes
three selectable screens to edit plug-in settings and reference version and legal info.

IMPORTANT! Be sure to backup your presets and impulses using the Export
options within the Librarian panels or Preferences window before using these
Clear and Restore features, since Librarian presets and impulses will be permanently deleted or overwritten, as indicated below.
•

•

Clear Preset Library - Instantly removes all presets in all setlists. This replaces
all with empty "new" presets, providing a clean library to create and import
presets as desired.
Restore Factory Setlists - Clears only Setlists 1, 2 & 8 and replaces them with
the Factory Setlists 1, 2 & 8 included with the currently installed version of Helix
Native.* All of your presets within any other Setlists remain unaffected.
*TIP: Note that when a new version of Helix Native is released, it may include
some new Factory Presets. If you already have a previous version of Helix
Native installed and install the newer version, you'll need to perform the Restore Factory Setlists function to get these new Factory Presets within your
plug-in's Presets Library.

The Helix Native Preferences window - General screen

•

Help Options

At the top right of the Preferences window, click the ? menu button and you can choose
Online Help to visit the line6.com Helix Native plug-in support site, or select Pilot's
Guide to launch the PDF you are now reading.
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Clear IR Library - Instantly removes all Impulse Responses from the IR Library
list. Use the Impulses panel's Import feature to import IR files from your computer's hard drive in whatever order you like.

•

Import & Export Bundle - A Bundle is a file containing the complete set of all
setlists and presets. These buttons allow you to Import a Helix Bundle file from
your hard drive, or create and save all the Helix Native Library's setlists and presets in their currently-saved state as a Bundle file to your hard drive. As noted
above, this is a great way to easily save a backup of all your Library presets and
restore them at any time. Please see "Importing and Exporting Helix Bundles"
on page 17 for details.

*NOTE: You must be actively signed in at all times if using Helix Native in the
15-day Trial Mode.

About Box

The About box screen provides full version information for the installed Helix Native
plug-in.

The Sign In pop-up window

If you have forgotten your sign in credentials, or have not yet created a Line6.com account, choose the Forgot my password/username or Create a Line 6 account option
within the window.
If you are already signed in and wish to sign out, choose the Sign Out option from the
gear button menu.

Authorize / Deauthorize your Computer
Authorizing your computer allows your purchased (or Trial version) Helix Native license
to be run on the computer. It is permitted to authorize a maximum of 3 of your computers
concurrently. If you've already authorized 3 computers, you can deauthorize one computer to free up one of these license authorizations - see "Authorizing your Computer"
on page 5 for details.

The Helix Native About box screen

Note that the "Helix Compatible" version number informs you which Helix device firmware version is recommended if you are to be sharing presets between Helix Native
plug-in and your Helix device. Please also see "Preset Compatibility with Helix Devices"
on page 12.

To Deauthorize your Computer - Open an instance of the Helix Native plug-in and
make sure you are signed in to your Line 6 acct (as covered in the previous section),
then complete the following.

Legal Information

If you Have Purchased & Authorized Helix Native - Click on the gear button
and choose the Deauthorize Computer option from the menu. The online deauthorization completes momentarily. Helix Native remains installed and selectable
within your host DAW app, but it will not process audio when deauthorized. Once
deauthorized, if you wish to use Helix Native on a different computer, follow the
Installation and Authorization steps (see page 3) on the new computer.

The Legal screen displays all the necessary trademark, copyright and other legal required statements for the Helix Native software.

Account Sign In / Sign Out
If you are not currently signed in, choose Sign In from the menu and enter your Line6.
com account user name and password in the Sign In pop-up window. You don't need
to be signed in for your licensed Helix Native plug-in to be functional, but you will need
to be signed in to Authorize or Deauthorize your computer, as covered in the following
sections.*

If you are Using the 15-day Trial Version of Helix Native - When signed in, you'll
see your time remaining for the trial displayed at the bottom right of the plug-in
window. At any time during your 15-day trial, or once the trial has expired, you
can click this time remaining indicator to purchase your software license. Click
Yes when prompted to do so and you'll be taken to the Line 6 Online Store to
make your purchase and be up and running Helix Native plug-in in minutes!
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Deauthorizing the Trial License from your Computer - You would likely only
want to deauthorize in the event that you wish to continue the Helix Native 15day trial on a different computer that you own (assuming you have time remaining in your trial). To continue your trial on a different computer, install Helix Native on the other computer and choose the Trial version.

Manage Account
Choose this menu option to be taken to the line6.com My Account page, where you
can view and update your Line 6 user account: View and register Line 6 gear, manage
add-ons and license purchases, update your personal information, and more.
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Model Lists

Distortion Models

To follow are the lists of all Effect, Amp, Speaker Cabinet & Microphone models included in Helix Native, as well as the original gear they are based on.* Models, in many
cases, include some unique parameters, typically based on the controls found on the
original gear we modeled. However, you will also find a set of options that are common
to model category types, as described in the sections that follow.
TIP: Most model parameters are able to be configured for automation control by your
host DAW software - see "The Automation/Controller Assign Tab" on page 34.

Effects Models
Helix Native includes all the effects models found within the award-winning Line 6 Helix
guitar processors. In addition, selected effects from the classic Line 6 DL4™, DM4™,
MM4™, and FM4™ stompboxes as well as M13®, M9®, and M5® processors are also
included, which are referred to as "Legacy" models.
The following Effects models are found within each of the Helix Native plug-in's respective block category menus (Distortion, Dynamics, EQ, etc.). Once you've selected an effects category in the plug-in's Model Browser menu, you'll see up to three effects subcategories: Mono, Stereo and Legacy. Mono models process in mono, as you'd expect,
collapsing the stereo output of any block preceding it to mono. Stereo models process
the signal as discrete stereo-in, stereo-out. Legacy type models, just as on earlier Line
6 devices, are a mixed bag and can be either mono, stereo or mono-in/stereo-out. See
"Block Order and Stereo Imaging" on page 28 for more info.

Distortion Models
Model

Subcategories Based On*

Kinky Boost

Mono, Stereo

Xotic® EP Booster

Deranged Master

Mono, Stereo

Dallas Rangemaster Treble Booster

Minotaur

Mono, Stereo

Klon® Centaur

Teemah!

Mono, Stereo

Paul Cochrane Timmy® Overdrive

Compulsive Drive

Mono, Stereo

Fulltone® OCD

Valve Driver

Mono, Stereo

Chandler Tube Driver

Top Secret OD

Mono, Stereo

DOD® OD-250

Scream 808

Mono, Stereo

Ibanez® TS808 Tube Screamer®

Hedgehog D9

Mono, Stereo

MAXON® SD9 Sonic Distortion

Model

Subcategories Based On*

Stupor OD

Mono, Stereo

BOSS® SD-1 Overdrive

Deez One Vintage

Mono, Stereo

BOSS® DS-1 Distortion (Made-in-Japan)

Deez One Mod

Mono, Stereo

BOSS® DS-1 Distortion (Keeley modded)

Vermin Dist

Mono, Stereo

Pro Co RAT

KWB

Mono, Stereo

Benadrian Kowloon Walled Bunny Distortion

Arbitrator Fuzz

Mono, Stereo

Arbiter® FuzzFace®

Triangle Fuzz

Mono, Stereo

Electro-Harmonix® Big Muff Pi®

Industrial Fuzz

Mono, Stereo

Z.Vex Fuzz Factory

Tycoctavia Fuzz

Mono, Stereo

Tycobrahe® Octavia

Thrifter Fuzz

Mono, Stereo

Line 6 Original

Wringer Fuzz

Mono, Stereo

Garbage's modded BOSS® FZ-2

Megaphone

Mono, Stereo

Megaphone

Bitcrusher

Mono, Stereo

Line 6 Original

Obsidian 7000

Mono, Stereo

Darkglass® Electronics Microtubes® B7K Ultra

Clawthorn Drive

Mono, Stereo

Wounded Paw Battering Ram

Tube Drive

Legacy

Chandler Tube Driver

Screamer

Legacy

Ibanez® Tube Screamer®

Overdrive

Legacy

DOD® Overdrive/Preamp 250

Classic Dist

Legacy

ProCo RAT

Heavy Dist

Legacy

BOSS® Metal Zone

Colordrive

Legacy

Colorsound® Overdriver

Buzz Saw

Legacy

Maestro® Fuzz Tone

Facial Fuzz

Legacy

Arbiter® Fuzz Face®

Jumbo Fuzz

Legacy

Vox® Tone Bender

Fuzz Pi

Legacy

Electro-Harmonix® Big Muff Pi®

Jet Fuzz

Legacy

Roland® Jet Phaser

L6 Drive

Legacy

Colorsound® Overdriver (modded)

L6 Distortion

Legacy

Line 6 Original

Sub Oct Fuzz

Legacy

PAiA Roctave Divider

Octave Fuzz

Legacy

Tycobrahe® Octavia

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Dynamics Models

Modulation Models

Model

Subcategories Based On*

Model

Subcategories Based On*

Deluxe Comp

Mono, Stereo

Line 6 Original

Bleat Chop Trem

Mono, Stereo

Lightfoot Labs Goatkeeper

Red Squeeze

Mono, Stereo

MXR Dyna Comp

Script Mod Phase

Mono, Stereo

MXR® Phase 90

Kinky Comp

Mono, Stereo

Xotic® SP Compressor

Ubiquitous Vibe

Mono, Stereo

Shin-ei Uni-Vibe®

LA Studio Comp

Mono, Stereo

Teletronix® LA-2A®

Deluxe Phaser

Mono, Stereo

Line 6 Original

3-Band Comp

Mono, Stereo

Line 6 Original

Gray Flanger

Mono, Stereo

MXR® 117 Flanger

Noise Gate

Mono, Stereo

Line 6 Original

Harmonic Flanger

Mono, Stereo

A/DA Flanger

Hard Gate

Mono, Stereo

Line 6 Original

Courtesan Flange

Mono, Stereo

Electro-Harmonix® Deluxe EM

Autoswell

Mono, Stereo

Line 6 Original

Dynamix Flanger

Mono, Stereo

Line 6 Original

Tube Comp

Legacy

Teletronix LA-2A

Chorus

Mono, Stereo

Line 6 Original

Red Comp

Legacy

MXR® Dyna Comp

70s Chorus

Mono, Stereo

BOSS® CE-1

Blue Comp

Legacy

BOSS CS-1

PlastiChorus

Mono, Stereo

Modded Arion SCH-Z chorus

Blue Comp Treb

Legacy

BOSS CS-1 (Treble switch on)

Trinity Chorus

Stereo

Dytronics® Tri-Stereo Chorus

Vetta Comp

Legacy

Line 6 Original

Bubble Vibrato

Mono, Stereo

BOSS® VB-2 Vibrato

Vetta Juice

Legacy

Line 6 Original

Vibe Rotary

Stereo

Fender® Vibratone

Boost Comp

Legacy

MXR® Micro Amp

122 Rotary

Stereo

Leslie® 122

145 Rotary

Stereo

Leslie® 145

Double Take

Mono, Stereo

Line 6 Original

AM Ring Mod

Mono, Stereo

Line 6 Original

Pitch Ring Mod

Stereo

Line 6 Original

Pattern Tremolo

Legacy

Line 6 Original

Panner

Legacy

Line 6 Original

Bias Tremolo

Legacy

1960 Vox® AC-15 Tremolo

Opto Tremolo

Legacy

1964 Fender® Deluxe Reverb®

Script Phase

Legacy

MXR® Phase 90 (script logo version)

Panned Phaser

Legacy

Ibanez® Flying Pan

Barberpole

Legacy

Line 6 Original

Dual Phaser

Legacy

Mu-Tron® Bi-Phase

U-Vibe

Legacy

Shin-ei Uni-Vibe®

Phaser

Legacy

MXR® Phase 90

®

®

®

®
®

EQ Models
Model

Subcategories Based On*

Simple EQ

Mono, Stereo

Line 6 Original

Low and High Cut

Mono, Stereo

Line 6 Original

Parametric

Mono, Stereo

Line 6 Original

10 Band Graphic

Mono, Stereo

MXR® 10-Band Graphic EQ

Cali Q Graphic

Mono, Stereo

MESA/Boogie® Mark IV Graphic EQ

Modulation Models
Model

Subcategories Based On*

Optical Trem

Mono, Stereo

Fender® optical tremolo circuit

60s Bias Trem

Mono, Stereo

Vox® AC-15 Tremolo

Tremolo/Autopan

Mono, Stereo

BOSS® PN-2

Harmonic Tremolo

Mono, Stereo

Line 6 Original

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Modulation Models

Delay Models

Model

Subcategories Based On*

Model

Subcategories Based On*

Pitch Vibrato

Legacy

BOSS VB-2

Harmony Delay

Stereo

Line 6 Original

Dimension

Legacy

Roland Dimension D

Bucket Brigade

Mono, Stereo

BOSS® DM-2

Analog Chorus

Legacy

BOSS® CE-1

Adriatic Delay

Mono, Stereo

BOSS® DM-2 w/ Adrian Mod

Tri Chorus

Legacy

Dytronics® Tri-Stereo Chorus

Adriatic Swell

Mono, Stereo

Line 6 Original

Analog Flanger

Legacy

MXR® Flanger

Elephant Man

Mono, Stereo

Electro-Harmonix® Deluxe Memory Man

Jet Flanger

Legacy

A/DA Flanger

Multi Pass

Mono, Stereo

Line 6 Original

AC Flanger

Legacy

MXR Flanger

Ping Pong

Legacy

Line 6 Original

80A Flanger

Legacy

A/DA Flanger

Dynamic

Legacy

TC Electronic® 2290

Frequency Shift

Legacy

Line 6 Original

Stereo

Legacy

Line 6 Original

Ring Modulator

Legacy

Line 6 Original

Digital

Legacy

Line 6 Original

Rotary Drum

Legacy

Fender® Vibratone

Dig w/Mod

Legacy

Line 6 Original

Leslie 145

Reverse

Legacy

Line 6 Original

Lo Res

Legacy

Line 6 Original

Tube Echo

Legacy

Maestro® Echoplex EP-1

Tape Echo

Legacy

Maestro® Echoplex EP-3

Sweep Echo

Legacy

Line 6 Original

Echo Platter

Legacy

Binson® EchoRec®

Analog Echo

Legacy

BOSS® DM-2

Analog w/Mod

Legacy

Electro-Harmonix® Deluxe Memory Man

®

®

®

Rotary Drum/Horn Legacy

®

Delay Models
Model

Subcategories Based On*

Simple Delay

Mono, Stereo

Line 6 Original

Mod/Chorus Echo

Mono, Stereo

Line 6 Original

Dual Delay

Stereo

Line 6 Original

Multitap 4

Stereo

Line 6 Original

Multitap 6

Stereo

Line 6 Original

Ping Pong

Stereo

Line 6 Original

Sweep Echo

Mono, Stereo

Line 6 Original

Ducked Delay

Mono, Stereo

TC Electronic® 2290

Reverse Delay

Mono, Stereo

Line 6 Original

Model

Subcategory

Based On*

Vintage Digital

Mono, Stereo

Line 6 Original

Glitz

Mono, Stereo

Line 6 Original

Vintage Swell

Mono, Stereo

Line 6 Original

Ganymede

Mono, Stereo

Line 6 Original

Pitch Echo

Mono, Stereo

Line 6 Original

Searchlights

Mono, Stereo

Line 6 Original

Transistor Tape

Mono, Stereo

Maestro® Echoplex EP-3

Plateaux

Mono, Stereo

Line 6 Original

Cosmos Echo

Mono, Stereo

Roland RE-201 Space Echo

Double Tank

Mono, Stereo

Line 6 Original

Auto-Volume Echo Legacy

Line 6 Original

Multi-Head

Roland® RE-101 Space Echo

Legacy

Reverb Models

®

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Reverb Models

Filter Models

Model

Subcategory

Based On*

Model

Subcategories Based On*

Plate

Legacy

Line 6 Original

Mutant Filter

Mono, Stereo

Musitronics® Mu-Tron® III

Room

Legacy

Line 6 Original

Mystery Filter

Mono, Stereo

Korg® A3

Chamber

Legacy

Line 6 Original

Autofilter

Mono, Stereo

Line 6 Original

Hall

Legacy

Line 6 Original

Voice Box

Legacy

Line 6 Original

Echo

Legacy

Line 6 Original

Tile

V Tron

Legacy

Musitronics® Mu-Tron® III

Legacy

Line 6 Original

Cave

Legacy

Line 6 Original

Q Filter

Legacy

Line 6 Original

Ducking

Legacy

Line 6 Original

Seeker

Legacy

Z Vex Seek Wah

Octo

Legacy

Line 6 Original

Obi Wah

Legacy

Oberheim® voltage-controlled S&H filter

'63 Spring

Legacy

Line 6 Original

Tron Up

Legacy

Musitronics® Mu-Tron® III (up position)

Spring

Legacy

Line 6 Original

Tron Down

Legacy

Musitronics® Mu-Tron® III (down position)

Particle Verb

Legacy

Line 6 Original

Throbber

Legacy

Electrix® Filter Factory

Slow Filter

Legacy

Line 6 Original

Spin Cycle

Legacy

Craig Anderton's Wah/Anti-Wah

Comet Trails

Legacy

Line 6 Original

Pitch/Synth Models
Model

Subcategories Based On*

Pitch Wham

Mono, Stereo

Digitech® Whammy®

Twin Harmony

Mono, Stereo

Eventide® H3000

Simple Pitch

Mono, Stereo

Line 6 Original

Dual Pitch

Mono, Stereo

Line 6 Original

3 OSC Synth

Stereo

Line 6 Original

3 Note Generator

Mono, Stereo

Line 6 Original

4 OSC Generator

Mono, Stereo

Line 6 Original

Bass Octaver

Legacy

EBS® OctaBass

Smart Harmony

Legacy

Eventide® H3000

Octi Synth

Legacy

Line 6 Original

Synth O Matic

Legacy

Line 6 Original

Attack Synth

Legacy

Korg® X911 Guitar Synth

Synth String

Legacy

Roland® GR700 Guitar Synth

Growler

Legacy

Line 6 Original

Wah Models
Model

Subcategories Based On*

UK Wah 846

Mono, Stereo

Vox® V846

Teardrop 310

Mono, Stereo

Dunlop® Cry Baby® Fasel model 310

Fassel

Mono, Stereo

Dunlop® Cry Baby® Super

Weeper

Mono, Stereo

Arbiter® Cry Baby®

Chrome

Mono, Stereo

Vox® V847

Chrome Custom

Mono, Stereo

Modded Vox® V847

Throaty

Mono, Stereo

RMC® Real McCoy 1

Vetta Wah

Mono, Stereo

Line 6 Original

Colorful

Mono, Stereo

Colorsound® Wah-fuzz

Conductor

Mono, Stereo

Maestro® Boomerang

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Volume/Pan Models
Model

Subcategories Based On*

Volume Pedal

Mono, Stereo

Line 6 Original

Gain

Mono, Stereo

Line 6 Original

Pan

Stereo

Line 6 Original

Stereo Width

Stereo

Line 6 Original

Common FX Settings
Parameter

Description

Drive

Adjusts the amount of overdrive, distortion, or fuzz.

Bass

Adjusts the bass level.

Mid

Adjusts the midrange level.

Treble

Adjusts the treble level.

Speed

Adjusts the speed of the effect, with higher settings providing faster
rates. Activate the model's Note Sync parameter to toggle between Hz and note values. Choosing a Hz value provides a specific
modulation speed in cycles per second; choosing a note value provides a time based on the current tempo. Not all Speed parameters
can be synced to note values, as they may be non-linear and highly
interactive.

Rate

Adjusts the rate of the effect, with higher settings providing faster
rates. Activate the model's Note Sync parameter to toggle between Hz and note values. Not all Rate parameters can be synced to
note values, as they may be non-linear and highly interactive.

Time

Adjusts the delay/repeat time, with higher settings providing longer
delays. Activate the model's Note Sync parameter to toggle between Hz and note values. Choosing a ms value provides a specific
time in milliseconds; choosing a note division value provides a time
based on the current tempo. With a note division value, this parameter’s value is retained when changing models.

Depth

Adjusts the intensity of the modulation. Higher settings result in more
extreme pitch bending, wobble, or throb, depending on the effect.

Feedback

Adjusts the amount of delayed signal fed back into the effect. Higher
settings can provide more dramatic textures.

Decay

Sets the length of time the reverb effect sustains.

Predelay

Determines the time before the reverb effect is heard.

Parameter

Description

Scale

On stereo delays, the Scale offers control over the left & right channel
repeats proportionately. The left channel repeats following the Time
value and the right channel will repeat at a time that is the percentage
of the left time. For example, if a delay's Time is set for 1 second and
the Scale set to 75%, the left channel will repeat at 1 second and the
right at 750 milliseconds (ms).

Spread

Spread differs slightly among stereo delay effects. For most delays,
it adjusts how widely the repeats bounce left and right. With the Ping
Pong Delay, for example, 0 is in the middle (mono), and 10 is full left to
right panning for the repeats.
For modulated stereo delays, Spread affects the LFOs' (low frequency
oscillators) stereo modulation behavior. At 0 the LFOs are in sync. At
10, the two LFOs are 180 degrees out of sync, so that when one side
is modulating up, the other side is modulating down.

Headroom

Some mod and delay pedals' internal signal paths exhibit a bit of grit,
especially when placed after a high-gain amp block. Negative values
increase the perceived amount of grit; positive values clean things up
a bit. At 0dB, the model behaves like the original pedal.

Low Cut
High Cut

Filters a portion of the block's bass and/or treble frequencies, which
can help remove rumble and/or high-end harshness.

Mix

Blends the effected "wet" signal vs. the "dry" signal passed through
the block. When set to 0%, the path bypasses the effect completely.
When set to 100%, the entire path is fed through the effect, and no
dry thru signal is heard.

Level

Adjusts the overall output level of the effects block. Be careful not to
boost this parameter too high on multiple blocks, as digital clipping
could occur. You should typically leave this at 0.0dB for most blocks.
Where the original pedal's level or volume knob behavior doesn't
really apply to dB values, 0.0-10 may be used.

Trails

Trails Off: Any delay repeats or reverb decays are instantly muted
when the block is bypassed.
Trails On: Any delay repeats or reverb decays continue to decay naturally when the block is bypassed or a different snapshot is selected.

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Amp Models

Amp Models

The following guitar & bass amp models are found within the Helix Native Amp+Cab,
Amp and Preamp block category menus. Note that you'll also see Guitar and Bass
subcategories for the Amp+Cab & Amp categories, and Guitar, Bass and Mic subcategories for the Preamp category.
•

•

•

Amp+Cab blocks include an Amp plus a matched Cab model. You can change
out the Cab for sonic variation (see the list of "Speaker Cabinet Models" on
page 52 ).
Amp blocks are identical to Amp+Cab blocks, except they contain no matched
Cab model. Using an Amp block is the best choice if you want to use an IR
block. Or try using a few IR or Cab blocks in a parallel Split Path for even more
variation.
Preamp versions of each amp model are also included, which provide the tone
of just the preamp stage of the amp. Preamp blocks require less computer processing than a full Amp block.

Amp Models
Model

Subcategory

Based On*

WhoWatt 100

Guitar

Hiwatt® DR-103 Brill

Soup Pro

Guitar

Supro® S6616

Stone Age 185

Guitar

Gibson® EH-185

Voltage Queen

Guitar

Victoria Vintage Queen

Tweed Blues Nrm

Guitar

Fender® Bassman® (normal channel)

Tweed Blues Brt

Guitar

Fender® Bassman® (bright channel)

US Small Tweed

Guitar

Fender® Champ®

US Deluxe Nrm

Guitar

Fender® Deluxe Reverb® (normal channel)

US Deluxe Vib

Guitar

Fender® Deluxe Reverb® (vibrato channel)

US Double Nrm

Guitar

Fender® Twin Reverb® (normal channel)

US Double Vib

Guitar

Fender® Twin Reverb® (vibrato channel)

Mail Order Twin

Guitar

Silvertone® 1484

Divided Duo

Guitar

÷13 JRT 9/15

Interstate Zed

Guitar

Dr Z® Route 66

Derailed Ingrid

Guitar

Trainwreck® Circuits Express

Jazz Rivet 120

Guitar

Roland® JC-120 Jazz Chorus

Essex A15

Guitar

Vox® AC-15

Model

Subcategory

Based On*

Essex A30

Guitar

Vox® AC-30 with top boost

A30 Fawn Nrm

Guitar

Vox® AC-30 Fawn (normal channel)

A30 Fawn Brt

Guitar

Vox® AC-30 Fawn (bright channel)

Matchstick Ch1

Guitar

Matchless® DC30 (channel 1)

Matchstick Ch2

Guitar

Matchless® DC30 (channel 2)

Matchstick Jump

Guitar

Matchless® DC30 (jumped)

Mandarin 80

Guitar

Orange® OR80

Brit J45 Nrm

Guitar

Marshall® JTM-45 (normal channel)

Brit J45 Brt

Guitar

Marshall® JTM-45 (bright channel)

Brit Trem Nrm

Guitar

Marshall® JTM-50 (normal channel)

Brit Trem Brt

Guitar

Marshall® JTM-50 (bright channel)

Brit Trem Jump

Guitar

Marshall® JTM-50 (jumped)

Brit Plexi Nrm

Guitar

Marshall® Super Lead 100 (normal channel)

Brit Plexi Brt

Guitar

Marshall® Super Lead 100 (bright channel)

Brit Plexi Jump

Guitar

Marshall® Super Lead 100 (jumped)

Brit P75 Nrm

Guitar

Park® 75 (normal channel)

Brit P75 Brt

Guitar

Park® 75 (bright channel)

Brit 2204

Guitar

Marshall® JCM-800

Placater Clean

Guitar

Friedman BE-100 (clean channel)

Placater Dirty

Guitar

Friedman BE-100 (BE/HBE channel)

Cartographer

Guitar

Ben Adrian Cartographer

German Mahadeva Guitar

Bogner® Shiva

German Ubersonic Guitar

Bogner® Überschall®

Cali Texas Ch1

Guitar

MESA/Boogie® Lone Star (clean channel)

Cali Texas Ch2

Guitar

MESA/Boogie® Lone Star (drive channel)

Cali IV Rhythm 1

Guitar

MESA/Boogie® Mark IV (channel I)

Cali IV Rhythm 2

Guitar

MESA/Boogie® Mark IV (channel II)

Cali IV Lead

Guitar

MESA/Boogie® Mark IV (lead channel)

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Common Amp Settings

Amp Models

Parameter

Description

Master

Adjusts the amount of power amp distortion. This parameter is highly
interactive with all other power amp parameters—the lower the Master
is set, the less effect the other controls will have.

Sag

Lower Sag values offer a "tighter" responsiveness for metal and djent
playing; higher values provide more touch dynamics & sustain for
blues and classic rock riffs.

Model

Subcategory

Based On*

Cali Rectifire

Guitar

MESA/Boogie® Dual Rectifier®

Archetype Clean

Guitar

Paul Reed Smith® Archon® (clean channel)

Archetype Lead

Guitar

Paul Reed Smith® Archon® (lead channel)

ANGL Meteor

Guitar

ENGL Fireball 100

Solo Lead Clean

Guitar

Soldano SLO-100 (clean channel)

Hum

Solo Lead Crunch

Guitar

Soldano SLO-100 (crunch channel)

Ripple

Controls how much heater hum and AC ripple interacts with your tone.
At higher settings, things get freaky.

Solo Lead OD

Guitar

Soldano SLO-100 (overdrive channel)

PV Panama

Guitar

Peavey 5150

Bias

Changes the Bias of the power tubes. Lower values achieve a "colder"
Class AB biasing. At maximum, the amp is operating in Class A.

Line 6 Elektrik

Guitar

Line 6 Original

Line 6 Doom

Bias X

Guitar

Line 6 Original

Determines how the power amp tubes' voicing reacts when pushed
hard. Set low for a tighter feel. Set high for more tube compression.
This parameter is highly reactive with the Drive and Master settings.

Line 6 Epic

Guitar

Line 6 Original

Line 6 2204 Mod

Guitar

Line 6 Original

Line 6 Fatality

Guitar

Line 6 Original

Line 6 Litigator

Guitar

Line 6 Original

Line 6 Badonk

Guitar

Line 6 Original

Tuck n' Go

Bass

Ampeg® B-15NF Portaflex®

SV Beast Nrm

Bass

Ampeg® SVT® (normal channel)

SV Beast Brt

Bass

Ampeg® SVT® (bright channel)

Woody Blue

Bass

Acoustic® 360

Agua 51

Bass

Aguilar® DB51

Cali Bass

Bass

MESA/Boogie® M9 Carbine

Cali 400 Ch1

Bass

MESA/Boogie® Bass 400+ (channel 1)

Cali 400 Ch2

Bass

MESA/Boogie® Bass 400+ (channel 2)

G Cougar 800

Bass

Gallien-Krueger® GK 800RB

Del Sol 300

Bass

Sunn® Coliseum 300

Busy One Ch1

Bass

Pearce BC-1 preamp (channel 1)

Busy One Ch2

Bass

Pearce BC-1 preamp (channel 2)

Busy One Jump

Bass

Pearce BC-1 preamp (jumped)

®

®

®

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Speaker Cabinet Models

Cab Models

The following Cab models are available within the Amp+Cab and Cab block category
menus. All Cab models also include your choice of Mic model type used on the Cab, as
well as several Mic settings (see the list of "Microphone Models" on page 53).

Model

There are two subcategories of Cab blocks—Single and Dual. Not surprisingly, Dual
Cabs take twice as much processor usage as single Cabs. When you select a Dual Cab
within the Model menu, you'll see two model tabs, allowing you to select the specific
cab and settings for each. Dual Cab blocks are stereo, with the two cabs panned hard
left and right.

Cab Models
Model

Subcategories

Based On*

Soup Pro Ellipse

Single, Dual

1 x 6x9" Supro® S6616

1x8 Small Tweed

Single, Dual

1x8" Fender® Champ

1x12 Field Coil

Single, Dual

1x12" Gibson® EH185

1x12 US Deluxe

Single, Dual

1x12" Fender® Deluxe Oxford

1x12 Celest 12H

Single, Dual

1x12" ÷13 JRT 9/15 G12 H30

1x12 Blue Bell

Single, Dual

1x12" Vox® AC-15 Blue

1x12 Lead 80

Single, Dual

1x12" Bogner® Shiva CL80

1x12 Cali IV

Single, Dual

1x12" MESA/Boogie® Mk IV

1x12 Cali Ext

Single, Dual

1x12" MESA/Boogie® EVM12L

2x12 Double C12N

Single, Dual

2x12" Fender® Twin C12N

2x12 Mail C12Q

Single, Dual

2x12" Silvertone® 1484

2x12 Interstate

Single, Dual

2x12" Dr Z® Z Best V30

2x12 Jazz Rivet

Single, Dual

2x12" Roland® JC-120

2x12 Silver Bell

Single, Dual

2x12" Vox® AC-30TB Silver

2x12 Blue Bell

Single, Dual

2x12" Vox® AC-30 Fawn Blue

2x12 Match H30

Single, Dual

1x12" Matchless® DC-30 G12H30

2x12 Match G25

Single, Dual

1x12" Matchless® DC-30 Greenback 25

4x10 Tweed P10R

Single, Dual

4x10" Fender® Bassman® P10R

Subcategories

Based On*

4x12 WhoWatt 100 Single, Dual

4x12" Hiwatt® AP Fane®

4x12 Mandarin EM Single, Dual

4x12" Orange® Eminence

4x12 Greenback25 Single, Dual

4x12" Marshall® Basketweave G12 M25

4x12 Greenback20 Single, Dual

4x12" Marshall® Basketweave G12 M20

4x12 Blackback30

Single, Dual

4x12" Park® 75 G12 H30

4x12 1960 T75

Single, Dual

4x12" Marshall® 1960 AT75

4x12 Uber V30

Single, Dual

4x12" Bogner® Uberkab V30

4x12 Uber T75

Single, Dual

4x12" Bogner® Uberkab T75

4x12 Cali V30

Single, Dual

4x12" MESA/Boogie® 4FB V30

4x12 XXL V30

Single, Dual

4x12" ENGL® XXL V30

4x12 SoloLead EM Single, Dual

4x12" Soldano

1x12 Del Sol

Single, Dual

1x12" Sunn® Coliseum

1x15 Tuck n' Go

Single, Dual

1x15" Ampeg® B-15

1x18 Del Sol

Single, Dual

1x18" Sunn® Coliseum

1x18 Woody Blue

Single, Dual

1x18" Acoustic® 360

2x15 Brute

Single, Dual

2x15" MESA/Boogie® 2x15 EV

4x10 Rhino

Single, Dual

4x10" Ampeg® SVT® 410HLF

6x10 Cali Power

Single, Dual

6x10" MESA/Boogie® Power House

8x10 SV Beast

Single, Dual

8x10" Ampeg® SVT®

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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Microphone Models
Mic Models
Model

Based On*

57 Dynamic

Shure® SM57

409 Dynamic

Sennheiser® MD 409

421 Dynamic

Sennheiser® MD 421-U

30 Dynamic

Heil Sound® PR 30

20 Dynamic

Electro-Voice® RE20

121 Ribbon

Royer® R-121

160 Ribbon

Beyerdynamic® M 160

4038 Ribbon

Coles 4038

414 Cond

AKG® C414 TLII

84 Cond

Neumann® KM84

67 Cond

Neumann® U67

87 Cond

Neumann® U87

47 Cond

Neumann® U47

112 Dynamic

AKG® D112

12 Dynamic

AKG® D12

7 Dynamic

Shure® SM7

Cab & Mic Settings
Knob Parameter

Description

1

Mic

Selects one of the 16 available mic models.

2

Distance

Sets the distance (1 inch to 12 inches) between the mic and
the speaker grille.

3

Low Cut

4

High Cut

Filters a portion of the cab's bass and/or treble frequencies,
which can help remove rumble and/or high-end harshness.

5

EarlyReflc

Sets the amount of "early reflections." Higher values add more
reflective room sound to your Amp tone.

6

Level

Adjusts the overall output level of the Cab.

*See "U.S. Registered Trademarks" on page 54. All product names are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound model development.
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U.S. Registered Trademarks

All product names used within this document are trademarks of their respective owners and appear solely to identify the products that were studied during Line 6's sound
model development.
5150 is a registered trademark of ELVH Inc.

Klon is a registered trademark of Klon, LLC.

Acoustic is a registered trademark of GTRC Services, Inc.

Korg is a registered trademark of Korg, Inc.

Aguilar is a registered trademark David Boonshoft.

Leslie is a registered trademark of Suzuki Musical Instrument Manufacturing Co. Ltd.

AKG, DOD and Whammy are registered trademarks of Harman International Industries,
Inc.

Lone Star is a registered trademark of Randall C. Smith.

Arbiter is a registered trademark of Sound City Amplification LLC.
Binson, Dytronics, LA-2A and Teletronix are registered trademarks of Universal Audio, Inc.
Beyerdynamic is a registered trademark of Beyer Dynamic GmbH & Co. KG.

Marshall is a registered trademark of Marshall Amplification Plc.
Matchless is a registered trademark of Matchless, LLC.
MAXON is a registered trademark of Nisshin Onpa Co., Ltd.
Mesa/Boogie and Rectifier are registered trademarks of Mesa/Boogie, Ltd.

Bogner and Überschall are registered trademarks of Bogner Amplification.

Musitronics is a registered trademark of Mark S. Simonsen.

BOSS and Roland are registered trademarks of Roland Corporation U.S.

Mu-Tron is a registered trademark of Henry Zajac.

Colorsound is a registered trademark of Sola Sound Limited Corporation, UK.
Cry Baby, Dunlop, Fuzz Face, MXR and Uni-Vibe are registered trademarks of Dunlop
Manufacturing, Inc.

Neumann is a registered trademark of Georg Neumann GmbH.
Orange is a registered trademark of Orange Brand Services Limited.

Darkglass and Microtubes are registered trademarks of Darkglass Electronics, TMI Douglas Castro.

Park is a registered trademark of AMP RX LLC.

Digitech is a registered trademark of DOD Electronics Corporation.

Peavey is a registered trademark of Peavey Electronics Corporation.

Dr. Z is a registered trademark of Dr. Z Amps, Inc.

RMC is a registered trademark of Richard McClish.

EBS is a registered trademark according of EBS Holding.

Royer is a registered trademark of Bulldog Audio, Inc. DBA Rover Labs.

EchoRec is a registered trademark of Nicholas Harris.

Sennheiser is a registered trademark of Sennheiser Electronic GmbH & Co. KG.

Electro-Harmonix and Big Muff Pi are registered trademarks of New Sensor Corp.

Shure is a registered trademark of Shure Inc.

Electro-Voice is a registered trademark of Bosch Security Systems, Inc.

Silvertone is a registered trademark of Samick Music Corporation.

Engl is a registered trademark of Beate Ausflug and Edmund Engl.

Supro is a registered trademark of Absara Audio LLC.

Eventide is a registered trademark of Eventide Inc.

TC Electronic is a registered trademark of MUSIC Group IP Ltd.

Fane is a trademark of Fane International Ltd.

Timmy is a registered trademark of Paul Cochrane AKA PAULCAUDIO.

Fender, Twin Reverb, Bassman, Champ, Deluxe Reverb and Sunn are registered trademarks of Fender Musical Instruments Corp.

Trainwreck is a registered trademark of of Scott Alan Fischer and Mona Fischer.

Fulltone is a registered trademark of Fulltone Musical Products, Inc.

Paul Reed Smith and Archon are registered trademarks of Paul Reed Smith Guitars, LP.

Tube Screamer is a registered trademark of Hoshino Gakki Co. Ltd.
Tycobrahe is a registered trademark of Kurt Stier.

Gallien-Krueger is a registered trademark of Gallien Technology, Inc.

Vox is a registered trademark of Vox R&D Limited.

Gibson and Maestro are registered trademarks of Gibson Guitar Corp.

Xotic is a registered trademark of Prosound Communications, Inc.

Heil Sound is a registered trademark of Heil Sound Ltd.
Hiwatt is a registered trademark of Simon Giles and Justin Harrison.
Ibanez is a registered trademark of Hoshino, Inc.
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Additional Resources
Looking for more info? We’ve got plenty of online resources, just a click away.
•
•
•
•
•

Download additional Help documentation covering Helix family devices and software from the Line 6 website at Line 6 Product Manuals
Check out the Line 6 Support page for access to helpful tips, videos, discussion
forums, or to contact Line 6 Technical Support
Stay up to date with the latest updated version of Helix Native and all your other
Line 6 applications, available from the Line 6 Software Downloads page
Visit the Line 6 CustomTone site where you can share your Helix presets with the
world, and download free presets created by Line 6 and other users just like you
Can’t get enough Line 6 Gear & accessories? Head on over to the Line 6 Store
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